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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.
Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License as set forth
below in the Designated System(s) License (DS) section as
applicable. The applicable number of licenses and units of capacity
for which the license is granted will be one (1), unless a different
number of licenses or units of capacity is specified in the
documentation or other materials available to You. “Software” means
computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes,
or modified versions thereto. “Designated Processor” means a single
stand-alone computing device. “Server” means a set of Designated
Processors that hosts (physically or virtually) a software application
to be accessed by multiple users. “Instance” means a single copy of
the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.
License type(s)
Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only: 1) on a number of
Designated Processors up to the number indicated in the order; or 2)
up to the number of Instances of the Software as indicated in the
order, Documentation, or as authorized by Avaya in writing. Avaya
may require the Designated Processor(s) to be identified in the order
by type, serial number, feature key, Instance, location or other
specific designation, or to be provided by End User to Avaya through
electronic means established by Avaya specifically for this purpose.
Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time as indicated in the order,
Documentation, or as authorized by Avaya in writing. A “Unit” means
the unit on which Avaya, at its sole discretion, bases the pricing of its
licenses and can be, without limitation, an agent, port or user, an e-
mail or voice mail account in the name of a person or corporate
function (e.g., webmaster or helpdesk), or a directory entry in the
administrative database utilized by the Software that permits one
user to interface with the Software. Units may be linked to a specific,
identified Server or an Instance of the Software.
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
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Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.
Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Unless
otherwise stated, each Instance of a product must be separately
licensed and ordered. For example, if the end user customer or
Avaya Channel Partner would like to install two Instances of the
same type of products, then two products of that type must be
ordered.
Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.
The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S

HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE H.264 CODEC OR H.265 CODEC, THE AVAYA CHANNEL
PARTNER ACKNOWLEDGES AND AGREES THE AVAYA
CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND ALL
RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) CODEC
IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE
FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES
IN WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.
Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
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affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
All non-Avaya trademarks are the property of their respective owners.
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Chapter 1: Introduction

Purpose
The purpose of this document is to provide information about how to use the features and
capabilities of Avaya Analytics™. This document also provides instructions to create a suite of
historical reports for Avaya Oceana® contact center activities.

This document is intended for users who want to use Avaya Analytics™ to create and view
historical reports for their Avaya Oceana® contact center activities.

Changes history

Issue Date Summary of changes
3.0 November 2021 Minor updates throughout the document.
2.0 April 2021 • Updates in several topics in the Managing historical reports

chapter.

• New topics in the Managing historical reports chapter:

- Scheduling a dossier

- Printing a dossier

- Subscribing to a dossier

• Updates in the Engagement, Contact Setail Summary, and
Time Series sections.

• Updates in several topics in the Call Profile reports chapter
1.0 April 2021 Initial release

New in this release
Avaya Analytics™ Release 4.1.1 includes the following features and enhancements:
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Support for historical reporting on routing service groups in
Avaya Analytics™

Avaya Analytics™ supports historical reporting on routing service groups. Supervisors can
effectively monitor the historical performance of routing services within a routing service group for
a specific reporting interval.
Avaya Analytics™ Historical Reporting provides options for users to import data from different data
sources and create reports, documents, and dossiers on their imported data.

Avaya Analytics™ Call Profile reports
Avaya Analytics™ Call Profile reports for Routing Service Groups report on the number of calls that
were Answered, Abandoned, Active, or Waiting in Queue for the following duration intervals (in
seconds): 5, 10, 20, 60, and 120+. The following Call Profile reports are available:

• Call Profile Abandoned
• Call Profile Answered
• Call Profile Active Time Duration
• Call Profile Waiting in Queue

Support for approval of outbound emails
Avaya Oceana® introduces support for approval of outbound agent email replies. For customer
satisfaction and to avoid escalations, an agent's email responses can now be routed through an
approval process.

Avaya Analytics™ supports the ability to generate custom reports on the approval or rejection of
the outbound emails for both real-time and historical operations.

Introduction
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Chapter 2: Overview

Avaya Analytics™ overview
Avaya Analytics™ is a microservices-based reporting solution that collects events from Avaya
Oceana®. These events are translated into Contact Center measures and stored in the reporting
database. With these measures, you can create a suite of historical reports for Avaya Oceana®.
The evolution of the Avaya Analytics™ reporting platform provides the ability to view and analyze
Avaya Oceana® data through historical interaction dashboards.

Avaya Analytics™ also offers a suite of measures for real-time dashboards to provide a view of the
key Contact Center KPIs to supervisors and Contact Center managers.

With the new interface of Avaya Analytics™, you can:

• Streamline contact center operations

• Reduce operational costs

• Provide enhanced services to customers

• Get insights from interactions to enhance customer experience and agent performance

• Analyze interaction types that Avaya Oceana® supports

Avaya Analytics™ provides a simplified installation through the adoption of Avaya Common
Services.

Historical reports overview
The historical dashboard reports display the historical data of the contact center resources, such
as agents and the routing services of the various routing service groups. These reports provide a
quick view of contact center performance for the specified time interval. You can use these reports
as references to evaluate the historical performance of the contact center agents and supervisors.
The data helps you to understand progress and performance over time and make informed
decisions for the contact center.
Historical reports use interval-based measures to display a snapshot of the contact center. All
historical summary and trend reports that return interval-based measures do not include data from
the current 15-minute interval until data aggregation is run for the interval. By default, report
caching settings are set to 15 minutes. Therefore, you might need to wait up to 30 minutes for the
data of the current interval to display in the report.
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You can also generate reports for a week, month, or year based on daily roll-up and monthly roll-
up data. The daily reports do not include data for the current day because the data is calculated
only the next day. The monthly reports do not include data for the current month because the data
is calculated the next month.
As supervisor, you can use the Call Profile reports to determine the routing services' call
performance in the routing service groups that they are assigned. You can compare the call
performance and decide whether you need to plan process improvements.

Note:
The data retention period for these reports is configurable. The maximum data retention
period for these reports are:

• 12 months for interval-based data
• 60 months for daily roll-up based data
• 9999 months for monthly roll-up based data

You can configure Routing Service Groups for Historical Reporting in Avaya Analytics™. The
default value for Routing Service Groups is Off. For more information about configuring Routing
Service Groups, see Chapter 2: Maintaining Avaya Analytics using the Cluster Control
Manager console > Configuring Routing Service groups for Historical Reporting topic in the
Maintaining and Troubleshooting Avaya Analytics for Avaya Oceana guide.

Historical Reporting offers:
• A web-based reporting application that provides historical reporting through a simplified

interface
With this interface, you can visualize the performance of the contact center over a specified
reporting time. The interface provides enhanced user experience for report creation.

• Consolidation of historical contact center performance and customer data across the contact
center

• Extensive library of tables, graphics, and ready-to-use displays
• Ability to drill-down to granular level information
• Filtering options
• Options to export reports to Excel and PDF formats

Note:
HTML data format is currently not supported.

• Ability to schedule reports to run at user-defined intervals
• Ability to schedule reports to run based on daily roll-up and monthly roll-up data
• Options for calculated measures
• Facility for time zone reporting to display data in the preferred time zone
• Multiple predefined reports
• Option to create custom reports or modify reports to meet your business requirements
• Option for advanced users to import data from different data sources to create reports,

documents, and dashboards to report on their imported data.

Overview
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• Option to export web objects for archiving the custom reports during an upgrade.
The historical reports based on interval data available in Avaya Analytics™ are:

• Account By Agent
• Agent By Routing Service
• Agent Configuration
• Agent Login/Logout Report
• Agent Not Ready by Reason Code
• Agent Performance Summary
• Contact Center
• Engagement
• Contact Detail
• Messaging Engagement Summary
• Routing Service
• Supervisor
• Time Series
• VDN

The historical reports based on daily roll-ups available in Avaya Analytics™ are:
• Account By Agent Daily
• Agent By Routing Service Daily
• Agent Not Ready by Reason Code Daily
• Agent Performance Summary Daily
• Contact Center Daily
• Routing Service Daily
• Supervisor Activity Daily
• Time Series Daily
• VDN Summary Daily

The historical reports based on monthly roll-ups available in Avaya Analytics™ are:
• Account By Agent Monthly
• Agent By Routing Service Monthly
• Agent Not Ready by Reason Code Monthly
• Agent Performance Summary Monthly
• Contact Center Monthly
• Routing Service Monthly
• Supervisor Activity Monthly

Historical reports overview
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• Time Series Monthly
• VDN Monthly

Supervisors can use Call Profile reports to view the count of Answered and Abandoned calls. The
Call Profile reports are:

• Call Profile Abandoned
• Call Profile Answered
• Call Profile Active Time Duration
• Call Profile Waiting in Queue

For more detailed information about the measures, data, and reports that Avaya Analytics™

provides, see Avaya Analytics™ Data Dictionary available from the Avaya Support website at 
https://support.avaya.com.

Avaya Analytics™ concepts
The following table lists Avaya Analytics™ concepts:

Concept Description
Report A request for a specific set of formatted data from your data source.

A report consists of the following two parts:

• A report template, which is the underlying structure of the report.

• The report-related objects that are placed on the template. For example,
attributes, metrics, filters, and prompts.

Document A document displays your organization’s data in a format similar to a
PowerPoint presentation. Several grid and graph reports can be viewed at
simultaneously with images and text. High-quality, Pixel Perfect™ documents
allow you to display your business data that is suitable for presentation to the
management. Examples of documents include the scorecards and dossiers,
managed metrics documents, production, and operational documents.

For example, a sales metrics document helps you analyze the sales deals and
sales amounts for different stages of the shipment process. The document
draws a visual representation of the sales and distribution process. It also
includes several metrics that measure overall performance for successful and
lost sales. You can use this document to understand overall sales activity,
starting from generating inquiries to delivering goods to their customers. You
can also use the data to analyze the key performance indicators that measure
the performance of the sales organization.

Table continues…
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Concept Description
Dossier A dossier is an interactive display to show and explore business data. Users

with permissions can create a dossier and add visual representations of the
data to the dossier to:

• Make the data easier to interpret

• Manipulate on the data to customize which information to display

• Organize data into multiple chapters and pages to provide a logical flow to
the dossier

Dossiers provide personalized views of corporate information. You can view
pre-configured dossiers or create your personalized views if you have the
required permissions. Users with administrative privileges can create shared
dossiers for groups of users with common responsibilities or job functions.

Attribute A dimension with properties such as Agent Name.
Metric A measure that provides calculation performed on the data. It specifies a

numeric value such as the number of offered calls.
Filter The default conditions based on which Avaya Analytics™ displays the results.
Prompt A type of filter where you provide inputs based on which Avaya Analytics™

displays the results.

User roles
Use the following table to understand the Avaya Analytics™ defined user privileges.

Persona Consumer Basic users Advanced users
You can • Run dossiers, reports,

and documents.

• Perform basic
operations, such as
sort, pivot, drill, and
export.

• All the capabilities
provided to the
consumer.

• Create new dossiers,
reports, and
documents.

• Modify or customize
Avaya Analytics™

canned reports.

• Access and import
data from local
machine for file
formats, such as excel
file, CSV files, and
JSON files.

• All the capabilities
provided to the basic
users.

• Interact with rest APIs
to push external data,
extract data subsets,
and create datasets.

• Connect and access
data from a range of
third-party databases.

Table continues…
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You cannot • Save or design new
dossiers, reports or
documents.

• Create objects like
prompts, filters, and
metrics.

• Create objects like
prompts and filters.

• Create schema objects
such as attributes and
facts.

• Leverage rest APIs.
For example, access
data pushed through
the API.

• Create schema objects
such as attributes,
facts, and hierarchies.

Important:
Do not run reports as an administrator user. In Avaya Analytics™, administrators cannot create
certain reports using their administrator user profiles. Additionally, some reports display
inaccurate statistics when administrator users create these reports.

Subscription of reports
Avaya Analytics™ provides an option to subscribe to a historical report so that you can receive
updated copies of the report.
If you want to set a date after which you do not want to receive subscription reports, on the
Subscription settings page, expand Advanced Options, select the Do not deliver after option,
and set the date.
To receive delivery notifications of your subscription reports by email, in the Delivery Notification
section under Advanced Options, select the Send notification to email address option. Then,
enter the email address in the New Address field.
The following table lists the types of subscriptions for a report:

Subscription Type Description
Personal view Saves a personal view of the reports generated on a given date and time into My

Subscriptions.

Table continues…
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Subscription Type Description
History List Contains the reports saved for future reference.

Using the History List, you can create shortcuts to previously generated reports and
also view the scheduled reports. History List subscriptions create a History List
message for the specified report. You can then retrieve the report from the History
List message in your History List folder.

The History List folder contains messages for all the projects on which you work.
The number of messages in this folder is controlled by the administrator, by the
setting Maximum number of messages per user.

For example, if you set this number at 40, and you have 10 messages for Project A
and 15 for Project B, you can have no more than 15 for Project C. When the
maximum number is reached, the oldest message in the current project is
automatically deleted.

Cache Update Refreshes the cache for the specified report. For example, your system contains a
set of standard weekly, monthly, and yearly reports. These reports must be kept in
cache if they are frequently accessed. Whenever the tables are updated, the
appropriate caches must be refreshed. Cache update subscriptions often use event-
triggered schedules for a refresh, because the caches are not required to be
refreshed unless the underlying data changes.

Email Delivers the subscribed reports to one or more email addresses as specified.
File Saves the subscribed reports as an Excel or PDF file to a specified disk location on

the network.
FTP Saves the subscribed reports to a location on an FTP server in the file format you

choose. The file format options are Comma Separated Values (CSV), PDF, HTML,
MS Excel, and plain text.

Print Prints the subscribed reports from a specified printer.
Mobile Saves the subscribed reportto a mobile device, which can be a phone or a tablet.

You can set a Schedule of your choice, such as 1st Day of Month or Weekly
Monday.

You can set one of the following Target Applications:

• Apple Push Notifications for Dossier on iPhone

• Apple Push Notifications for Library on iPad

• Google Cloud Messaging for Dossier on Android

• Mobile APNS for iPad

• Mobile APNS for iPhone

• Mobile FCS for Android

Subscription of reports
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Chapter 3: Getting Started

Logging on to Avaya Analytics™

About this task
Use this procedure to log on to the Avaya Analytics™ interface by using a supported browser. You
must always use HTTPS for a secure connection.
For the list of supported browsers, see the Avaya Oceana® Solution Description document.

Before you begin
Do the following procedures described in Maintaining and Troubleshooting Avaya Analytics™:

• Creating a local user for Historical Reporting
• Adding a local user to a group
• Removing a local user from a group

Procedure
1. In the address bar of your browser, enter the following URL:

https://<FQDN>/AvayaAnalytics/servlet/AnalyticsWeb
In this URL, replace <FQDN> with the FQDN of the cluster configured during deployment.

2. Select Standard to log on as a local user or select LDAP Authentication to log on as an
LDAP user.

3. In the User name field, type your user name.

4. In the Password field, type your password.

5. Click Login.

Avaya Analytics™ displays the Projects page.

6. Select the project.

Avaya Analytics™ displays the Home page.

Avaya Analytics™ home page field descriptions
The following table lists the fields and buttons available on the Avaya Analytics™ home page:
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Name Description
Shared Reports A public folder containing canned reports and

documents. The content of this folder is available to
all users irrespective of user roles.

My Reports A personalized folder containing the reports that
you create.

History List A folder containing previously run and scheduled
reports.

My Subscriptions A folder where you can view and manage your
report subscriptions.

Create Dossier The button to create a dossier.
Add External Data The button to import data from an external source.
Create Report The button to create a grid or graph report from

scratch or a template.
Create Document The button to create a document that displays your

organization’s data in a format similar to a
PowerPoint presentation.

Create Filter The button to create a filter to limit the data returned
by a query.

Create Prompt The button to create a filter to define the content of
a report.

Create Metric The button to create a metric to analyze data.
Create Custom Group The button to create a custom group to segment

data.

Important:
The fields and buttons are available to users based on their roles. For information about the
user roles, see User roles on page 15.

Shared Reports page field descriptions
The following table lists the folders available on the Shared Reports page:

Name Description
Custom Reports The folder containing the user-defined or custom

reports or dashboards that are accessible to all
users.

Standard Historical Reports The folder that contains standard historical reports
and documents of Avaya Analytics™.

Logging on to Avaya Analytics™
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Standard Historical Reports page field descriptions
The following table lists the folders and documents available on the Standard Historical Reports
page:

Name Description
Daily Contains all canned reports that you can use to:

• Customize respective documents

• Create new documents and dossiers

These reports are based on daily roll-up data
tables.

Monthly Contains all canned reports that you can use to:

• Customize respective documents

• Create new documents and dossiers

These reports are based on monthly roll-up data
tables.

Reports Contains all canned reports that can be used to:

• Customize respective documents

• Create new documents and dossiers

These reports are based on interval data tables.
Call Profile Contains the following Call Profile reports:

• Call Profile Abandoned

• Call Profile Active Time Duration

• Call Profile Answered

• Call Profile Waiting in Queue
Account By Agent Displays a summary of agents who handled the

contacts for the accounts during the current interval.
Agent By Routing Service Displays how the agents use routing services for

the current interval.
Agent Configuration Displays the agent information and properties.
Agent Login/Logout Displays the login and logout information of agents.

The information includes the login and logout time,
total login duration, and the attributes associated
with agents when they log in to the reporting
interval.

Agent Not Ready By Reason Code Displays the reason code associated with the agent
auxiliary state.

Table continues…
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Name Description
Agent Performance Summary Displays the performance and productivity of an

agent by channels for the current interval.
Contact Center Displays the performance summary of a contact

center site.
Contact Detail Report Displays the details of segments, and the segment

durations of an engagement.
Engagement Displays the data related to the customer

engagements across various parameters.
Messaging Engagement Report Displays the data related to customer engagements

originated on the Messaging channel across various
parameters.

Routing Service Displays the overall performance of a routing
service for the selected interval.

Supervisor Displays a summary of the supervisor’s activity for
the current reporting interval.

Time Series Displays the engagement of agents with an
individual routing service for the current interval.

VDN Summary Displays the overall performance of a routing point
for customer experience.

Reports page field descriptions
The following table lists the reports available on the Reports page:

Name Description
Account By Agent Displays a summary of agents who handled the

contacts for the accounts during the current interval.
Agent by Routing Service Displays how the agents use routing services for

the current interval.
Agent Configuration Displays the agent information and properties.
Agent Login/Logout Displays the login and logout information of agents.

The information includes the login and logout time,
total login duration, and the attributes associated
with agents when they log in to the reporting
interval.

Agent Not Ready By Reason Code Displays the reason code associated with the agent
auxiliary state.

Table continues…
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Name Description
Agent Performance Displays the performance and productivity of an

agent by channels for the current interval.

This report consists of four reports:

• Agent Performance Summary: Displays the
performance and productivity of an agent by
Channels for the current interval.

• Agent Performance Top 5 and Bottom 5:
Displays a performance summary of the top five
and the bottom five agents for the current interval.

• Agent Compare: Displays a comparison of
different agent measures.

• Agent Behavior: Displays individual occurrences
of agent behaviors that are associated with
engagement handling activities.

Call Profile Abandoned Displays the number of calls that were abandoned
for each of the routing services in a Routing Service
Group.

Call Profile Active Time Duration Displays the duration for which calls were active for
each of the routing services in a Routing Service
Group.

Call Profile Answered Displays the number of calls that were answered for
each of the routing services in a Routing Service
Group.

Call Profile Waiting in Queue Displays the number of calls that were waiting in a
queue for each of the routing services in a Routing
Service Group.

Contact Center Displays the performance summary of a contact
center site.

Contact Detail Displays the details of segments, segment
durations of an engagement, and a count of email
engagements.

Engagement Report Displays the data related to the customer
engagements across various parameters.

Messaging Engagement Report Displays the data related to customer engagements
originated on the Messaging channel across various
parameters.

Routing Service Displays the overall performance of a routing
service for the selected interval.

Table continues…
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Name Description
Supervisor Displays a summary of the supervisor’s activity for

the current reporting interval.

This report consists of three reports:

• Supervisor Activity: Displays a summary of the
supervisor’s activity for the current reporting
interval.

• Supervised Agent Activity: Displays details of
supervised agents and their behavior aspects in
the current reporting interval.

• Supervised Agent Compare: Displays a
comparison of supervised agents for the current
reporting interval.

VDN Displays the overall performance of a routing point
for customer experience.

Daily page field descriptions
The following table lists the folders and documents available on the Daily page:

Name Description
Reports Contains all canned reports that you can use to:

• Customize respective documents

• Create new documents and dossiers

These reports are based on daily roll-up data.
Account By Agent Daily Displays a summary of agents who handled the

contacts for the accounts during the selected
duration.

Agent By Routing Service Daily Displays how the agents use routing services for
the selected duration.

Agent Not Ready By Reason Code Daily Displays the reason code associated with the agent
auxiliary state.

Agent Performance Summary Daily Displays the performance and productivity of an
agent by channels for the selected duration.

Contact Center Daily Displays the performance summary of a contact
center site.

Routing Service Daily Displays the overall performance of a routing
service for the selected duration.

Supervisor Daily Displays a summary of the supervisor’s activity for
the selected reporting duration.

Table continues…
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Name Description
Time Series Daily Displays the engagement of agents with an

individual routing service for the selected duration.
VDN Summary Daily Displays the overall performance of a routing point

for customer experience.

Reports page field descriptions
The following table lists the reports available on the Reports page inside the Daily folder:

Name Description
Account By Agent Daily Displays a summary of agents who handled the

contacts for the accounts during the selected
duration.

Agent By Routing Service Daily Displays how the agents use routing services for
the selected duration.

Agent Not Ready by Reason Code Daily Displays the reason code associated with the agent
auxiliary state.

Agent Performance Summary Daily Displays the performance and productivity of an
agent by channels for the selected duration.

Contact Center Daily Displays the performance summary of a contact
center site.

Routing Attribute Timeline Daily Displays the timeline of the routing attribute for the
selected duration.

Routing Service Daily Displays the overall performance of a routing
service for the selected duration.

Supervisor Activity Daily Displays a summary of the supervisor’s activity for
the selected reporting duration.

Supervisor Daily Displays a summary of the supervisor’s activity for
the selected reporting duration.

Time Series Daily Displays the engagement of agents with an
individual routing service for the selected duration.

VDN Daily Displays the overall performance of a routing point
for customer experience.

Monthly page field descriptions
The following table lists the folders and documents available on the Monthly page:
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Name Description
Reports Contains all canned reports that you can use to:

• Customize respective documents

• Create new documents and dossiers

These reports are based on monthly roll-up data.
Account By Agent Monthly Displays a summary of agents who handled the

contacts for the accounts during the selected
duration.

Agent By Routing Service Monthly Displays how the agents use routing services for
the selected duration.

Agent Not Ready By Reason Code Monthly Displays the reason code associated with the agent
auxiliary state.

Agent Performance Summary Monthly Displays the performance and productivity of an
agent by channels for the selected duration.

Contact Center Monthly Displays the performance summary of a contact
center site.

Routing Service Monthly Displays the overall performance of a routing
service for the selected duration.

Supervisor Monthly Displays a summary of the supervisor’s activity for
the selected reporting duration.

Time Series Monthly Displays the engagement of agents with an
individual routing service for the selected duration.

VDN Summary Monthly Displays the overall performance of a routing point
for customer experience.

Reports page field descriptions
The following table lists the reports available on the Reports page inside the Monthly folder:

Name Description
Account By Agent Monthly Displays a summary of agents who handled the

contacts for the accounts during the selected
duration.

Agent By Routing Service Monthly Displays how the agents use routing services for
the selected duration.

Agent Comparison Monthly Displays the perfomance comparison of agents for
the selected duration.

Agent Not Ready by Reason Code Monthly Displays the reason code associated with the agent
auxiliary state.

Table continues…
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Name Description
Agent Performance Summary Monthly Displays the performance and productivity of an

agent by channels for the selected duration.
Contact Center Monthly Displays the performance summary of a contact

center site.
Routing Attribute Timeline Monthly Displays the timeline of the routing attribute for the

selected duration.
Routing Service Monthly Displays the overall performance of a routing

service for the selected duration.
Supervisor Activity Monthly Displays a summary of the supervisor’s activity for

the selected reporting duration.
Supervisor Monthly Displays a summary of the supervisor’s activity for

the selected reporting duration.
VDN Monthly Displays the overall performance of a routing point

for customer experience.

Call Profile page field descriptions
The following table lists the Call Profile reports available on the Call Profile page:

Name Description
Call Profile Abandoned Displays a summary of abandoned calls for a

routing service for specified durations.
Call Profile Active Time Duration Displays a summary of calls with active time for a

routing service for specified durations.
Call Profile Answered Displays a summary of answered calls for a routing

service for specified durations.
Call Profile Waiting in Quese Displays a summary of calls waiting in a queue for a

routing service for specified durations

Configuring the default landing page
About this task
By default, after logging on to Avaya Analytics™, a common landing page is displayed as
configured by the administrator. Use this procedure to set the landing page of your choice for your
user account.
For example, if your default landing page is configured by the administrator to show the My
Reports page, you can change it to view My Subscriptions or History List.
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Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, click the user account name list in the top-right corner.

3. Click Preferences.

Avaya Analytics™ displays the User Preference page.

4. In the Default start page field, select an option from the drop-down list to set it as landing
page for your account.

The available options vary depending on the administrator’s configuration.

5. Select Apply to Current project <Name of project> from the drop-down list.

6. Click Apply.

7. Log out and log on again to view the landing page you configured.

Configuring the default language
About this task
Use this procedure to configure the default language for your user account in Avaya Analytics™.
The supported languages are:

• Chinese (Simplified)
• Chinese (Traditional)
• English
• French
• German
• Italian
• Japanese
• Korean
• Portuguese
• Russian
• Spanish

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, click the user account name list in the top-right corner.

3. Click Preferences.

Avaya Analytics™ displays the User Preference page.

Configuring the default language
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4. In the Language field, select your preferred language.

5. (Optional) For advanced options, click Show advanced options and select the inputs.

6. Select Apply to Current project <Name of project> from the drop-down list.

7. Click Apply.

8. Log out and log on again to verify the configured language.

Configuring the default time zone
About this task
Use this procedure to configure the default time zone for your user account.

Note:
This time zone is for the historical report interface and not for the reports data.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, click the user account name list in the top-right corner.

3. Click Preferences.

Avaya Analytics™ displays the User Preference page.

4. In the Time Zone field, select your time zone.

5. Select Apply to Current project <Name of project> from the drop-down list.

6. Click Apply.

7. Log out and log on again to verify the configured time zone.

Configuring the number of columns and rows in a grid
About this task
You can limit the number of rows or columns that are displayed in your report at one time. You can
use the incremental fetch icons to view the additional data. The default value for both for rows is
50 and the default value for columns is 10.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, click the user account name list in the top-right corner.

3. Click Preferences.
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Avaya Analytics™ displays the User Preference page.

4. In the navigation pane, click Grid display.

Avaya Analytics™ displays the Grid display content pane.

5. In the Maximum columns in grid field, change the value based on your requirement.

The maximum value that you can configure in this field is 200.

6. In the Maximum rows in grid field, change the value based on your requirement.

The maximum value that you can configure in this field is 200.

7. Clear the Automatic page-by check box.

8. Click Apply.

9. Log out and log in again to verify the configured number of columns and rows.

10. (Optional) To reset the default options, click Load Default Values.

Configuring email addresses
About this task
Use this procedure to configure email addresses in Avaya Analytics™.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, click the user account name list in the top-right corner.

3. Click Preferences.

Avaya Analytics™ displays the User Preference page.

4. Under Preferences menu in the left navigation panel, click E-mail Addresses.

5. On the E-mail Addresses page, click Add a New Address.

6. Enter a name and email address in the Address Name and Physical Address fields,
respectively.

7. Select the device from the Device list.

The default value is Generic email.

8. Click Save to save this email address or Cancel to cancel the operation.

9. To edit or delete an existing email address, click Edit/Delete corresponding to the email
address.

10. To set a default email address, in the Default column, select the option corresponding to
the email address and click Set New Default.

Configuring email addresses
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Avaya Analytics™ saves your personal preferences.

Changing the user's password
About this task
Users can change their passwords in the Preferences section after logging in to Avaya Analytics™.
Use this procedure to change the password for your user account:

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, click the user account name list in the top-right corner.

3. Click Preferences.

Avaya Analytics™ displays the User Preference page.

4. Under Preferences in the left panel, click Change Password.

5. Enter your old password in the Old password field.

6. Enter your new password in the New password and New password verification fields.

7. Click Change Password.

8. Log out and log in again with the new password.
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Chapter 4: Real-time reports

Real-time reports overview
In an Avaya Oceana®, the Supervisor Reporting Dashboard provides real-time reporting
capabilities. Using Avaya Workspaces, supervisors can run real-time reporting dashboards to
monitor up-to-date statistics for your contact center and resources. You can view changes in call
activity in real-time using the Supervisor Reporting Dashboard. Avaya Analytics™ provides the
real-time data for your dashboards. For more information about using the Supervisor Reporting
Dashboard, see Using Avaya Workspaces for Avaya Oceana®.

For detailed information about realtime measures, data, and reports that Avaya Analytics™

provides, see Avaya Analytics™ Data Dictionary available on the Avaya Support website at https://
support.avaya.com.
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Chapter 5: Managing historical reports

Historical reports overview
The historical dashboard reports display the historical data of the contact center resources, such
as agents and the routing services of the various routing service groups. These reports provide a
quick view of contact center performance for the specified time interval. You can use these reports
as references to evaluate the historical performance of the contact center agents and supervisors.
The data helps you to understand progress and performance over time and make informed
decisions for the contact center.
Historical reports use interval-based measures to display a snapshot of the contact center. All
historical summary and trend reports that return interval-based measures do not include data from
the current 15-minute interval until data aggregation is run for the interval. By default, report
caching settings are set to 15 minutes. Therefore, you might need to wait up to 30 minutes for the
data of the current interval to display in the report.
You can also generate reports for a week, month, or year based on daily roll-up and monthly roll-
up data. The daily reports do not include data for the current day because the data is calculated
only the next day. The monthly reports do not include data for the current month because the data
is calculated the next month.
As supervisor, you can use the Call Profile reports to determine the routing services' call
performance in the routing service groups that they are assigned. You can compare the call
performance and decide whether you need to plan process improvements.

Note:
The data retention period for these reports is configurable. The maximum data retention
period for these reports are:

• 12 months for interval-based data
• 60 months for daily roll-up based data
• 9999 months for monthly roll-up based data

You can configure Routing Service Groups for Historical Reporting in Avaya Analytics™. The
default value for Routing Service Groups is Off. For more information about configuring Routing
Service Groups, see Chapter 2: Maintaining Avaya Analytics using the Cluster Control
Manager console > Configuring Routing Service groups for Historical Reporting topic in the
Maintaining and Troubleshooting Avaya Analytics for Avaya Oceana guide.

Historical Reporting offers:
• A web-based reporting application that provides historical reporting through a simplified

interface
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With this interface, you can visualize the performance of the contact center over a specified
reporting time. The interface provides enhanced user experience for report creation.

• Consolidation of historical contact center performance and customer data across the contact
center

• Extensive library of tables, graphics, and ready-to-use displays
• Ability to drill-down to granular level information
• Filtering options
• Options to export reports to Excel and PDF formats

Note:
HTML data format is currently not supported.

• Ability to schedule reports to run at user-defined intervals
• Ability to schedule reports to run based on daily roll-up and monthly roll-up data
• Options for calculated measures
• Facility for time zone reporting to display data in the preferred time zone
• Multiple predefined reports
• Option to create custom reports or modify reports to meet your business requirements
• Option for advanced users to import data from different data sources to create reports,

documents, and dashboards to report on their imported data.
• Option to export web objects for archiving the custom reports during an upgrade.

The historical reports based on interval data available in Avaya Analytics™ are:
• Account By Agent
• Agent By Routing Service
• Agent Configuration
• Agent Login/Logout Report
• Agent Not Ready by Reason Code
• Agent Performance Summary
• Contact Center
• Engagement
• Contact Detail
• Messaging Engagement Summary
• Routing Service
• Supervisor
• Time Series
• VDN

Historical reports overview
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The historical reports based on daily roll-ups available in Avaya Analytics™ are:
• Account By Agent Daily
• Agent By Routing Service Daily
• Agent Not Ready by Reason Code Daily
• Agent Performance Summary Daily
• Contact Center Daily
• Routing Service Daily
• Supervisor Activity Daily
• Time Series Daily
• VDN Summary Daily

The historical reports based on monthly roll-ups available in Avaya Analytics™ are:
• Account By Agent Monthly
• Agent By Routing Service Monthly
• Agent Not Ready by Reason Code Monthly
• Agent Performance Summary Monthly
• Contact Center Monthly
• Routing Service Monthly
• Supervisor Activity Monthly
• Time Series Monthly
• VDN Monthly

Supervisors can use Call Profile reports to view the count of Answered and Abandoned calls. The
Call Profile reports are:

• Call Profile Abandoned
• Call Profile Answered
• Call Profile Active Time Duration
• Call Profile Waiting in Queue

For more detailed information about the measures, data, and reports that Avaya Analytics™

provides, see Avaya Analytics™ Data Dictionary available from the Avaya Support website at 
https://support.avaya.com.

Prompts
In Avaya Analytics™, Advanced users can create prompts to apply the following attributes to a
document or report:

• Filtering conditions

Managing historical reports
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• A custom group

• A metric

These prompts are available as Shared prompts for Basic users who can then use these prompts
in the reports that they create. When you run a document or report after specifying the values in
the prompts, Avaya Analytics™ returns data based on the specified values. You can also use a
search object in the prompts. A search object searches and displays the specific objects the
moment you access the report. You can select your answers from the most up-to-date hierarchies,
attributes, metrics, or other objects in a project.

In Avaya Analytics™, the different prompts are:

• Hierarchy qualification prompt: To create customized report filter by using attributes and
attribute elements from a specific hierarchy, the hierarchies in the project, or specific
hierarchies returned by a search object.

• Attribute qualification prompt: To qualify on the ID, description, and other form of an attribute.

• Attribute element list: To choose from a list of elements. You can use this prompt to create a
filter that displays a specific list of attribute elements, based on the condition defined in the
filter.

• Metric qualification prompt: To determine how the data in a report is filtered based on one or
more specific metrics on the report.

• Object prompt: To select one or more objects, such as attributes, metrics, or filters to include
in a report.

• Value prompt: To select a single value, such as a date or a specific text string, and filter
report data based on your selection.

Important:

To make the best use of prompts, frame clear descriptions for the prompts so that the users
have a clarity on the questions they are answering.

Note:

On standard reports, you can use the Reprompt option from the menu in the right pane to
reset time or group. The report displays without errors. However, you cannot create reprompts
on drilldown reports. If you attempt to do so, Avaya Analytics™ displays a timeout error.

Use the following procedures to create the different prompts and understand when to create the
respective prompts in Avaya Analytics™.

Creating hierarchy qualification prompt
About this task
Using a hierarchy qualification prompt, you can create a customized report filter using attributes
and attribute elements from:

• A specific hierarchy
For example, you can select agents with a specific skill from an agent groups hierarchy.

Historical reports overview
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• All hierarchies in the project
For example, you can select agents with different skills from an agent groups hierarchy.

• Specific hierarchies returned by a search object

Note:
While running a report or document, hierarchical or cascaded prompts remain available in the
Available list even after moving them to the Selected list.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Prompt > Hierarchy Qualification Prompt.
3. On the Definition tab, in the Reduce the number of hierarchies available at run time

area, select one of the following:

• All hierarchies: To choose all hierarchies.

• Choose a hierarchy: To choose a hierarchy from the list, click Select Hierarchy,
choose a hierarchy from the available list, and click OK.

• Use a predefined list of hierarchies: To add the required hierarchies to a predefined
list, click Add, move the required hierarchies from the available list to the selected list,
and click OK.

• Use the result of a search object: To use the search object results to choose the
hierarchies, click Select Search.

4. On the General tab, do the following:

a. In the Title field, type the title.

b. In the Instructions field, type the instructions for the hierarchy qualification prompt.

c. If the user input is mandatory, select Prompt answer is required check box.

d. To define the minimum number of qualifications, select Minimum number of
qualifications check box and type the minimum number.

e. To define the maximum number of qualifications, select Maximum number of
qualifications check box and type the maximum number.

f. To save a specific answer as a default prompt, in the Personal answers allowed
field, click Single or Multiple.

If you select Single, you can save one personal prompt answer.

If you select Multiple, you can save multiple answers for different situations.

5. On the Style tab, select the required style specifications.

6. On the Qualification tab, select the required expressions and conditions.

7. Click the Save icon.

The Save As dialog box opens.
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8. In the Name field, type a name for the prompt.

9. In the Description field, type the description for the prompt.

10. Navigate to the appropriate location, and click OK.

Creating an attribute qualification prompt
About this task
With an attribute qualification prompt, you can qualify on the ID, description, and other form of an
attribute. You can use an attribute qualification prompt when you want to prompt on a specific
attribute form. For example, if your report contains the attribute Channel, then you can create an
attribute qualification prompt, which prompts you to choose attribute elements from the Channel
attribute, such as voice, message, and chat.

Note:
This prompt is more restrictive than the hierarchy qualification prompt because the user has
fewer attribute elements to select answers.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Prompt > Attribute Qualification Prompt.
3. On the Definition tab, select one of the following:

a. Choose an attribute: To choose an attribute from the list, click Select Attribute,
choose the attribute, and click OK.

b. Use a predefined list of attributes: To add the required attributes to a predefined
list, click Add, move the required attributes from the available list to the selected list,
and click OK.

c. Use the result of a search object: To use the search object results to choose the
attributes, click Select Search.

4. On the General tab, do the following:

a. In the Title field, type the title.

b. In the Instructions field, type the instructions for the attribute qualification.

c. If the user input is mandatory, select the Prompt answer is required check box.

d. To define the minimum number of qualifications, select the Minimum number of
qualifications check box and type the minimum number.

e. To define the maximum number of qualifications, select the Maximum number of
qualifications check box and type the maximum number.

f. To save a specific answer as a default prompt, in the Personal answers allowed
field, click Single or Multiple.

If you select Single, you can save one personal prompt answer.

If you select Multiple, you can save multiple answers for different situations.
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5. On the Style tab, select the required style specifications.

6. On the Qualification tab, select the required expressions and conditions.

7. Click the Save icon.

The Save As dialog box opens.

8. In the Name field, type a name for the prompt.

9. In the Description field, type the description for the prompt.

10. Navigate to the appropriate location, and click OK.

Creating an attribute element list
About this task
With the attribute element list prompt, you can choose from a list of elements. This prompt is the
most restrictive of the filter definition prompts because you have a limited number of attribute
elements to select answers. For example, you can define a prompt to choose the list of elements
in a month.

Important:
• Use attribute qualification prompt to select prompt answers from a list of attribute

elements from a single attribute.
• Use attribute element list to select prompt answers from a limited list of the specific

attribute elements.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Prompt > Attribute Element List.
3. On the Definition tab, do the following:

a. Specify the attribute: To specify an attribute, click Select Attribute, choose an
attribute from the list, and click OK.

b. In the Define Elements section, choose one of the following:

• List all elements (no restriction): To choose all elements.

• Use a predefined list of elements: To add the required attributes elements to a
predefined list, click Add, move the required elements from the available list to the
selected list, and click OK.

• Use a filter to reduce the number of elements: To use the filter to restrict the
number of elements, click Select Filter.

4. On the General tab, do the following:

a. In the Title field, type the title.

b. In the Instructions field, type the instructions for the elements.

c. If the user input is mandatory, select Prompt answer is required check box.
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d. To define the minimum number of qualifications, select Minimum number of
answers check box and type the minimum number.

e. To define the maximum number of qualifications, select Maximum number of
answers check box and type the maximum number.

f. To select a default answer, in the Personal answers allowed field, click Single or
Multiple.

If you select Single, you can save one personal prompt answer.

If you select Multiple, you can save multiple answers for different situations.

5. On the Style tab, select the required style specifications.

6. Click the Save icon.

The Save As dialog box opens.

7. In the Name field, type a name for the prompt.

8. In the Description field, type the description for the prompt.

9. Navigate to the appropriate location, and click OK.

Creating a metric qualification prompt
About this task
With a metric qualification prompt, you can qualify on one or more metrics to determine how the
report data is filtered based on metrics.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Prompt > Metric Qualification Prompt.
3. On the Definition tab, to Choose a metric or a metric search object, select one of the

following:

a. Choose a metric: To choose a metric from the list, click Select Metric, choose a
metric from the available list, and click OK.

b. Use a predefined list of metrics: To add the required metrics to a predefined list,
click Add, move the required metrics from the available list to the selected list, and
click OK.

c. Use the result of a search object: To use the search object results to choose the
metrics, click Select Search.

4. On the General tab, do the following:

a. In the Title field, type the title.
b. In the Instructions field, type the instructions for the metrics qualification.
c. If the user input is mandatory, select Prompt answer required check box.
d. To define the minimum number of qualifications, select Minimum number of

qualifications check box and type the minimum number.
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e. To define the maximum number of qualifications, select Maximum number of
qualifications check box and type the maximum number.

5. On the Style tab, select the required style specifications.

6. On the Qualification tab, select the required expressions and conditions.

7. Click the Save icon.

The Save As dialog box opens.

8. In the Name field, type a name for the prompt.

9. In the Description field, type the description for the prompt.

10. Navigate to the appropriate location, and click OK.

Creating object prompt
About this task
In Avaya Analytics™, you can use object prompts to select one or more objects to include in a
report. Objects here refer to attributes, metrics, or filters. You can also choose from a selection of
filters to apply a filter that is important for detailed analysis. For example, you can create a prompt
that displays the day, month, and year attributes to specify the granularity of the report.

Important:
• Use object prompts to add more data to a report.
• Use attribute qualification prompts to select prompt answers from a list of attribute

elements from a single attribute.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Prompt > Object Prompt.
3. On the Definition tab, in the List of objects to display section, select one of the

following:

a. Use a predefined list of objects: To add the required objects to a predefined list,
click Add, move the required objects from the available list to the selected list, and
click OK.

b. Use the result of a search object: To use the search object results to choose the
objects, click Select Search.

4. On the General tab, do the following:

a. In the Title field, type the title.

b. In the Instructions field, type the instructions for the object prompt.

c. If the user input is mandatory, select Prompt answer required check box.

d. To define the minimum number of qualifications, select Minimum number of
answers check box and type the minimum number.
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e. To define the maximum number of qualifications, select Maximum number of
answers check box and type the maximum number.

f. To create default personal answers, in the Personal answers allowed field, click
Single or Multiple.

If you select Single, you can save one personal prompt answer.

If you select Multiple, you can save multiple answers for different situations.

5. On the Style tab, select the required style specifications.

6. Click the Save icon.

The Save As dialog box opens.

7. In the Name field, type a name for the prompt.

8. In the Description field, type the description for the prompt.

9. Navigate to the appropriate location, and click OK.

Creating a value prompt
About this task
With a value prompt, users can enter a text, date, number, or other value types.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Prompt > Value Prompt.
3. On the Definition tab, to Choose the value prompt type, select one of the following:

a. Date & Time prompt
b. Numeric prompt
c. Text prompt
d. Big Decimal prompt

4. On the General tab, do the following:

a. In the Title field, type the title.

b. In the Instructions field, type the instructions for the prompt.

c. If the user input is mandatory, select the Prompt answer required check box.

d. To define the minimum number of answers:

• For Date & Time, Numeric, or Big Decimal prompt types, select the Minimum
value check box and type the minimum number.

• For a Text prompt type, select the Minimum number of characters check box and
type the minimum number.
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e. To define the maximum number of answers:

• For Date & Time, Numeric, or Big Decimal prompt types, select the Maximum
value check box and type the maximum number.

• For a Text prompt type, select the Maximum number of characters check box and
type the maximum number.

5. On the Style tab, select the required style specifications.

6. Click the Save icon.

The Save As dialog box opens.

7. In the Name field, type a name for the prompt.

8. In the Description field, type the description for the prompt.

9. Navigate to the appropriate location, and click OK.

Creating a filter for attributes and metrics
About this task
In Avaya Analytics™, Advanced users can use the following procedure to create a filter for
attributes and metrics to limit the data returned by a query.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New filter.
3. To apply a filter on attributes, do the following:

a. In the navigation pane, click Attributes and double-click the attribute for which you
want to create a filter.

b. To qualify, click Qualify, choose the operator from the drop-down, enter a value or
attribute, and click Apply.

c. To apply filters on lists, click Select, move the required parameters from Available to
the Selected list, and click Apply.

4. To apply a filter on metrics, do the following:

a. In the navigation pane, click Metrics and double-click the metrics for which you want
to create a filter.

b. Choose the operator from the drop-down, enter a value or metric, and click Apply.

5. Click Save and navigate to the appropriate location, name the file, and click OK.
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Creating a custom group
About this task
In Avaya Analytics™, Advanced users can create a custom group to segment data. Use the
following procedure to create a custom group:

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Custom Group.

The Custom Group Editor page opens.

3. To enter a name for the new custom group, click Enter Custom Group name here.

4. To enter a description for the custom group, click Enter Custom Group description here.

5. To add an element, do the following:

a. Click + New custom group element.

The Condition Editor window opens.

b. Click Browse. Select the required attribute or metric and the conditions.

c. Click OK.

Repeat step 5 to add more elements to the custom group.

6. Click Save.

Creating a new report
About this task
Use this procedure to create a new report so that you can request for a specific set of formatted
data from your data source.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Report.
3. Click Blank Report.

An empty report opens on which you can place various data objects to build a report.

4. From the ALL OBJECTS drop-down, select Avaya Analytics.

5. Click Objects > Avaya Analytics.

6. To add an attribute or metric to a report, expand the sub folders and then double-click or
drag and drop to the report.
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Attributes are placed on the rows of a report and metrics are placed on the columns of a
report.

7. To add a filter to a report, expand the Filters sub folder and then drag and drop the filter to
the REPORT FILTER area.

8. To add a prompt to a report, expand the Prompts sub folder and then drag and drop the
prompt to the REPORT FILTER area.

Note:
• For more information on attributes, filters, prompts, and metrics, see Avaya

Analytics™ Data Dictionary.

• If you create a report by using attributes and metrics from mismatched folders, you
might experience incompatibility issues.

9. Click the Run Report icon at the top of the page.

You can view the report in the Grid, Graph, or Grid and Graph view.

10. (Optional) To add more attributes, metrics, prompts, and filters to the report, click Edit to
return to Design Mode and make your changes.

11. Click Save As.

The Save As dialog box opens.

12. In the Save in field, select the location where you want to store the report.

13. In the Name field, type a name for the report.

14. In the Description field, type the description for the report.

15. Click OK.

Avaya Analytics™ displays the following message:

<Report Name> has been saved successfully.
16. Click one of the following options based on your requirement:

• Return to Design Mode
• Run newly saved report

Note:

The newly created report can be used as a dataset for other documents.

Creating a new document
About this task
Use this procedure to create a new document to view your organization’s data in a format similar
to a Power Point presentation.
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Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Document.

Avaya Analytics™ displays the Dashboard-style Templates and the Document Templates

3. To select a new document with predefined sections, click one of the dashboard-style
templates.

For example, if you select the Two Titles and Two Contents template, Avaya Analytics™

creates a template with 4 panels, one for titles and the other for content.

4. In the Document Templates section, click Blank Document.

Avaya Analytics™ creates a document in design mode.

5. Import a layout from an existing document.

6. Add a dataset to a document.

7. Add objects to a document.

8. Add a report to a document.

9. Click the Save icon.

The Save As dialog box opens.

10. In the Name field, type a name for the document.

11. In the Description field, type the description for the document.

12. Navigate to the appropriate location and click OK.

Importing a layout to a document
About this task
Use this procedure to import a layout from an existing document.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Document.
3. Click Blank Document.

A new document opens in Design Mode.

4. Click Tools > Import Document.
5. Browse to select the required document to use the layout.

6. Click OK.

The selected layout is applied to the document.
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Adding a dataset to a document
About this task
Use this procedure to add a dataset to a blank document.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Document.
3. Click Blank Document.

A new document opens in Design Mode.

4. Click Data > Add dataset.

The Select Dataset dialog box opens.

5. Browse to select the required report to use as a dataset.

You can select one or more datasets.

6. To locate a specific dataset, type a name in the Find field.

7. Click OK.

The selected dataset and its objects are displayed in the DATASET OBJECTS panel.

Note:

For more information on attributes, filters, prompts, and metrics, see Avaya Analytics™

Data Dictionary.

Adding objects to a document
About this task
Use this procedure to add a dataset to a blank document.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Document.
3. Click Blank Document.

A new document opens in Design Mode.

4. Click Tools > DOCUMENT STRUCTURE.

5. Click the Insert menu tab.

6. Click the object you require and then click on the section where you want to place the
selected object.

7. Repeat Step 6 to add more objects to the document.

The selected objects are displayed in the DOCUMENT STRUCTURE panel.
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Adding a report to a document
About this task
Use this procedure to add a report to a document.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Document.
3. Click Blank Document.

A new document opens in Design Mode.

4. Click Tools > DOCUMENT STRUCTURE.

5. Click the Insert menu tab.

6. To create a grid, click Grid and then click the section where you want to place the report.

7. To create a graph, point to Graph and select the graph type.

8. Add dataset objects to an empty Grid or Graph.

Creating a dossier
About this task
Use this procedure to create a dossier, which is an interactive display of call profile information of
your organization.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Dossier.

The created dossier displays a single blank visualization.

3. You can add data to the dossier in any of the following ways:

• New data: To import data from your local machine.

• Existing data: To select a dataset from one of the connected databases.

• Existing Objects: To create a new dataset using attributes and metrics available on one
of the connected environments.

The selected data is added to your dossier as a dataset.

4. To add a visual representation of your data, do the following:

• Click the graph style of your choice from the available styles on the right-hand side.

• Double-click the attributes and metrics to display the data using the graph style that you
have chosen.
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• Select additional display options, such as size or color graph items based on attributes
or metric values.

5. Click Save.

Customizing the layout of a document
About this task
You can customize the layout of a report or a document based on your business requirements.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For documents based on interval data, do the following:

a. Click the required document.

To choose an appropriate document from the list of the available documents, see 
Standard Historical Reports page field descriptions on page 20.

b. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For documents based on daily roll-up data, do the following:

a. Click Daily.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Daily page field descriptions on page 23.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For documents based on monthly roll-up data, do the following:

a. Click Monthly.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Monthly page field descriptions on page 24.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. Click Run Document.
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Avaya Analytics™ displays the report summary page based on the values specified in the
input prompts.

8. On the report page, click the hamburger icon ( ) and click Edit.

The DOCUMENT STRUCTURE page opens with options to edit the following parts of the
report structure in the left panel:

• Page Header

• Layout Header

• Detail Header

• Detail

• Body

• Detail Footer

• Layout Footer

• Page Footer

9. Drag and drop the text boxes, report graphics, drop-down structures to customize the
report layout based on your business requirements.

10. To add more metrics or attributes to the existing document, drag and drop the attributes or
metrics from the DATASET OBJECTS folder to the grid report in the document.

11. If a metric or attribute is not available in the current dataset, do the following:

a. Right-click the dataset name and click Replace Dataset.

Avaya Analytics™ displays the Select Dataset dialog box.

b. Select the dataset from Avaya Analytics™ or an external location.

c. (Optional) To select the dataset from Avaya Analytics™, click the Select your dataset
report below drop-down and select the required dataset.

d. (Optional) To select the dataset from an external location, click Add External Data
and select the dataset.

e. Click OK.

Avaya Analytics™ displays the Replace Objects dialog box.

f. Replace or remove attributes or metrics that are currently used in the document.

g. Click OK.

h. Drag and drop the attributes or metrics from the DATASET OBJECTS folder to the
grid report in the document.

12. Click DOCUMENT HOME > Save As.

Avaya Analytics™ displays the Save As dialog box.

13. In the Save in field, select My Reports.
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14. In the Name field, type a name for the report.

15. In the Description field, type a short description of the report.

16. In the Advanced field, select one of the following prompts based on your requirements:

• Display prompt and use the current answers as the default answers
• Display prompt but discard the current answers
• Do not display prompt and use the current answers as the default answers

17. Click OK.

Modifying an existing Avaya Analytics™ canned document
Procedure

1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For documents based on interval data, do the following:

a. Click the required document.

To choose an appropriate document from the list of the available documents, see 
Standard Historical Reports page field descriptions on page 20.

b. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For documents based on daily roll-up data, do the following:

a. Click Daily.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Daily page field descriptions on page 23.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For documents based on monthly roll-up data, do the following:

a. Click Monthly.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Monthly page field descriptions on page 24.
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c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. For dossiers based on Call Profile reports, do the following:

a. Click Call Profile.

b. Click one of the four Call Profile reports.

• Call Profile Abandoned

• Call Profile Active Time Duration

• Call Profile Answered

• Call Profile Waiting in Queue

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 72.

8. Click Run Document.

If you are working on Call Profile reports, click Run Dossier.

Avaya Analytics™ displays the document based on the input prompts.

9. On the document page, click the hamburger icon ( ) and click Run as Editable Mode.

If you are working on a Call Profile report, in the left pane, click the Click to Open Editor
Panel icon.

10. To modify the document, on the left-bottom panel, you can perform the following actions:

• DATASET OBJECTS: Drag and drop the attributes, metrics, and modify the document
layout.

Note:

For more information on attributes, filters, prompts and metrics, see Avaya
Analytics™ Data Dictionary.

• DOCUMENT STRUCTURE: You can modify the page header, layout header, detail
header, detail, body, detail footer, layout footer, and page footer of the report structure.

• NOTES: You can add your own notes or comments to the report.

• RELATED REPORTS: You can view the links to the other reports and documents
present in the same folder.

11. Click Save.

Customizing an existing report
About this task
Using the Report Editor you can create, customize, and save reports.
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Procedure
1. Log on to Avaya Analytics™.

2. Navigate to the report you want to customize.

3. You can navigate to the Report Editor in two ways:

• Move the cursor on the report and click Edit.
• Run the report and click the Design ( ) icon .

The Report Editor opens a report in Design Mode.

4. In the navigation pane, click ALL OBJECTS.

5. From the ALL OBJECTS drop-down, select Avaya Analytics.

6. Click Objects > Avaya Analytics.

7. To add an attribute or metric to a report, expand the sub folders and then double-click or
drag and drop to the report.

Attributes are placed on the rows of a report and metrics are placed on the columns of a
report.

8. To remove an attribute or metric, remove it from the grid.

9. To add a filter to a report, expand the Filters sub folder and then drag and drop the filter to
the REPORT FILTER area.

10. To add a prompt to a report, expand the Prompts sub folder and then drag and drop the
prompt to the REPORT FILTER area.

Note:

For more information on attributes, filters, prompts, and metrics, see Avaya Analytics™

Data Dictionary.

11. To remove a filter or prompt, remove it from the REPORT FILTER area.

12. Click the Run Report icon at the top of the page.

You can view the report in the Grid, Graph, or Grid and Graph view.

13. (Optional) To add more attributes, metrics, prompts, and filters to the report, click Edit to
return to Design Mode and make your changes.

14. Click Save As.

The Save As dialog box opens.

15. In the Save in field, select the location where you want to store the report.

You must save custom reports in the custom folder or My Reports folder.

16. In the Name field, type a name for the report.

17. In the Description field, type the description for the report.

18. Click OK.
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Avaya Analytics™ displays the following message:

<Report Name> has been saved successfully.
19. Click one of the following options based on your requirement:

• Return to Design Mode
• Run newly saved report

Note:

The newly created report can be used as a dataset for other documents.

Viewing a report based on interval data
About this task
Use this procedure to generate and view a report that uses interval-based measures. These
reports do not include data from the current 15-minute interval until you run data aggregation for
the interval. By default, report caching settings are set to 15 minutes.

Important:
To run a report, you must only use Supervisor credentials.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. On the Standard Historical Reports page, click Reports.

5. On the Reports page, click a report.

For the list of available reports, see Reports page field descriptions on page 21.

6. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

7. Click Run Report.

Avaya Analytics™ generates the report based on the input prompts.

8. In the report, drill-down the required measure to obtain information about the measure.

Note:

You can drill down only those measures in the reports that are underlined.
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Input prompts
The attributes in the following tables list out attributes for the following interval data: Interval, Date,
Week, Month, and Year. These tables list the input prompts that you use to run a document or
report:

Account By Agent
Name Description
Timezone The timezone for displaying results on the

document or report.
Time Filter The attributes to define the duration for displaying

results on the document or report.
Agent Group-Agent-Supervisor The agent groups with agents and their supervisor.

To filter results on the document or report, you can
move the required agent groups, agents, and
supervisors from the Available list to the Selected
list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Agent By Routing Service
Name Description
Timezone The timezone for displaying results on the

document or report.
Time Filter The attributes to define the duration for displaying

results on the document or report.
Routing Service Group - Routing Service Name The name of the routing service in a routing service

group that is used to route this contact to the agent.
To filter results on the document or report, you can
move the required routing service or routing service
group from the Available list to the Selected list. By
default, the Search for field option is disabled for
this prompt. However, this field gets enabled when
you select the attribute.

Agent Configuration
Name Description
Agent Group-Agent-Supervisor The agent groups with agents and their supervisor.

To filter results on the document or report, you can
move the required agent groups, agents, and
supervisors from the Available list to the Selected
list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.
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Agent Login/Logout
Name Description
Timezone The timezone for displaying results on document or

report.
Time Filter The attributes to define the duration for displaying

results on the document or report.
Agent Group-Agent The agent groups with agents. To filter results on

the document or report, you can move the required
agent groups and agents from the Available list to
the Selected list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Supervisor ID: Supervisor Name The name and ID of supervisors. To filter results on
the document or report, you can move the required
supervisors from the Available list to the Selected
list.

Agent Not Ready By Reason Code
Name Description
Timezone The timezone for displaying results on the

document or report.
Time Filter The attributes to define the duration for displaying

results on the document or report.
Agent Group-Agent The agent groups with agents. To filter results on

the document or report, you can move the required
agent groups and agents from the Available list to
the Selected list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Not Ready Reason Code The ID of the Not Ready Reason Code (Aux
Code).To filter results on the document or report,
you can move the required IDs from the Available
list to the Selected list.

Agent Performance Summary
Name Description
Timezone The timezone for displaying results on the

document or report.
Time Filter The attributes to define the duration for displaying

results on the document or report.

Table continues…
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Name Description
Agent Group-Agent-Supervisor The agent groups with agents and their supervisor.

To filter results on the document or report, you can
move the required agent groups, agents, and
supervisors from the Available list to the Selected
list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Contact Center
Name Description
Timezone The timezone for displaying results on the

document or report.
Time Filter The attributes to define the duration for displaying

results on the document or report.

Engagement
Name Description
Timezone The timezone for displaying results on the

document or report.
Start Date The start date for displaying results on the

document or report.
End Date The end date for displaying results on the document

or report.
Channel ID The channel ID of the engagement.
Engagement ID The source system ID to uniquely identify the

engagement.

Messaging Engagement Summary Report
Name Description
Timezone The timezone for displaying results on the

document or report.
Start Date The start date for displaying results on the

document or report.
End Date The end date for displaying results on the document

or report.

Routing Service
Name Description
Timezone The timezone for displaying results on the

document or report.

Table continues…

Managing historical reports

November 2021 Using Avaya Analytics™ Reports for Avaya Oceana® 56
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Analytics™‎ Reports for Avaya Oceana®‎


Name Description
Time Filter The attributes to define the duration for displaying

results on the document or report.
Routing Service Group - Routing Service Name The name of the routing service in a routing service

group that is used to route this contact to the agent.
To filter results on the document or report, you can
move the required routing service or routing service
group from the Available list to the Selected list. By
default, the Search for field option is disabled for
this prompt. However, this field gets enabled when
you select the attribute.

Supervisor
Name Description
Timezone The timezone for displaying results on the

document or report.
Time Filter The attributes to define the duration for displaying

results on the document or report.
Supervisor ID: Supervisor Name The name and ID of supervisors. To filter results on

the document or report, you can move the required
supervisors from the Available list to the Selected
list.

Time Series
Name Description
Timezone The timezone for displaying results on the

document or report.
Time Filter The attributes to define the duration for displaying

results on the document or report.

VDN Summary
Name Description
Timezone The timezone for displaying results on the

document or report.
Time Filter The attributes to define the duration for displaying

results on the document or report.
Routing Point ID: Routing Point Name The name and ID of routing points. To filter results

on the document or report, you can move the
required routing points from the Available list to the
Selected list.

Note:
While running a report or document, hierarchical or cascaded prompts such as Agent Group-
Agent-Supervisor remain available in the Available list even after moving them to the
Selected list.
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Input prompts page buttons
The following table lists the buttons on the input prompts page of each document:

Button Description
Run Document To generate the document.
Cancel To cancel generating the document.

Report summary page controls
The following actions are available on the report summary page depending on your permissions:

Action Description
Save To save a copy of the report.
Add to History List To send a report to the History List, to be saved for

future reference.
Create Personal View To create and save a personal view of the report

generated on a given date and time.
Share To share the report generated through an email link

or embedded report links in a web page.
Send Now To send a report to any email address.
Export To export the report in the required export format.

For example, Excel and PDF data formats.

Note:

HTML data format is currently not supported.
Print To print the report using Adobe Portable Document

Format (PDF).
Full Screen Mode To view the report summary page on the full screen.

Viewing a report based on daily roll-up data
About this task
Use this procedure to generate and view a report based on daily roll-up data. These reports do not
include data for the current day because the data is calculated only the next day.

Important:
To run a report, you must only use Supervisor credentials.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Managing historical reports

November 2021 Using Avaya Analytics™ Reports for Avaya Oceana® 58
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Analytics™‎ Reports for Avaya Oceana®‎


Avaya Analytics™ displays the Standard Historical Reports page.

4. Click Daily > Reports.

5. On the Reports page, click a report.

For a list of available reports, see Reports page field descriptions on page 24.

6. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

7. Click Run Report.

Avaya Analytics™ generates the report based on the input prompts.

Input prompts
The following tables list the input prompts that you use to run a document or report based on daily
roll-up tables:

Account By Agent Daily
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Agent Group-Agent-Supervisor The agent groups with agents and their supervisor.

To filter results on the document or report, you can
move the required agent groups, agents, and
supervisors from the Available list to the Selected
list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Agent By Routing Service Daily
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Routing Service Group - Routing Service Name The name of the routing service in a routing service

group that is used to route this contact to the agent.
To filter results on the document or report, you can
move the required routing service or routing service
group from the Available list to the Selected list. By
default, the Search for field option is disabled for
this prompt. However, this field gets enabled when
you select the attribute.
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Agent Not Ready By Reason Code Daily
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Agent Group-Agent The agent groups with agents. To filter results on

the document or report, you can move the required
agent groups and agents from the Available list to
the Selected list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Not Ready Reason Code The ID of the Not Ready Reason Code (Aux
Code).To filter results on the document or report,
you can move the required IDs from the Available
list to the Selected list.

Agent Performance Summary Daily
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Agent Group-Agent The agent groups with agents. To filter results on

the document or report, you can move the required
agent groups, agents, and supervisors from the
Available list to the Selected list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Contact Center Daily
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
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Routing Service Daily
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Routing Service Group - Routing Service Name The agent groups with agents. To filter results on

the document or report, you can move the required
agent groups, agents, and supervisors from the
Available list to the Selected list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Supervisor Daily
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.

Time Series Daily
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.

VDN Summary Daily
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Routing Point ID: Routing Point Name The name and ID of routing points. To filter results

on the document or report, you can move the
required routing points from the Available list to the
Selected list. By default, the Search for field
option is disabled for this prompt. However, this field
gets enabled when you select the attribute.

Note:
While running a report or document, hierarchical or cascaded prompts such as Agent Group-
Agent remain available in the Available list even after moving them to the Selected list.
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Input prompts page buttons
The following table lists the buttons on the input prompts page of each document:

Button Description
Run Document To generate the document.
Cancel To cancel generating the document.

Report summary page controls
The following actions are available on the report summary page depending on your permissions:

Action Description
Save To save a copy of the report.
Add to History List To send a report to the History List, to be saved for

future reference.
Create Personal View To create and save a personal view of the report

generated on a given date and time.
Share To share the report generated through an email link

or embedded report links in a web page.
Send Now To send a report to any email address.
Export To export the report in the required export format.

For example, Excel and PDF data formats.

Note:

HTML data format is currently not supported.
Print To print the report using Adobe Portable Document

Format (PDF).
Full Screen Mode To view the report summary page on the full screen.

Viewing a report based on monthly roll-up data
About this task
Use this procedure to generate and view a report based on daily roll-up data. These reports do not
include data for the current month because the data is calculated only the next month.

Important:
To run a report, you must only use Supervisor credentials.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.
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Avaya Analytics™ displays the Standard Historical Reports page.

4. Click Monthly > Reports.

5. On the Reports page, click a report.

For a list of available reports, see Reports page field descriptions on page 25.

6. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. Click Run Report.

Avaya Analytics™ generates the report based on the input prompts.

Input prompts
The following tables list the input prompts that you use to run a document or report based on
monthly roll-up tables:

Account By Agent Monthly
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Agent Group-Agent-Supervisor The agent groups with agents and their supervisor.

To filter results on the document or report, you can
move the required agent groups, agents, and
supervisors from the Available list to the Selected
list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Agent By Routing Service Monthly
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Routing Service Group - Routing Service Name The name of the routing service in a routing service

group that is used to route this contact to the agent.
To filter results on the document or report, you can
move the required routing service or routing service
group from the Available list to the Selected list. By
default, the Search for field option is disabled for
this prompt. However, this field gets enabled when
you select the attribute.
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Agent Not Ready By Reason Code Monthly
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Agent Group-Agent The agent groups with agents. To filter results on

the document or report, you can move the required
agent groups and agents from the Available list to
the Selected list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Not Ready Reason Code The ID of the Not Ready Reason Code (Aux
Code).To filter results on the document or report,
you can move the required IDs from the Available
list to the Selected list.

Agent Performance Summary Monthly
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Agent Group-Agent The agent groups with agents. To filter results on

the document or report, you can move the required
agent groups, agents, and supervisors from the
Available list to the Selected list.

By default, the Search for field is disabled for this
prompt. However, this field gets enabled on attribute
selection.

Contact Center Monthly
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
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Routing Service Monthly
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Routing Service Group - Routing Service Name The name of the routing service in a routing service

group that is used to route this contact to the agent.
To filter results on the document or report, you can
move the required routing service or routing service
group from the Available list to the Selected list. By
default, the Search for field option is disabled for
this prompt. However, this field gets enabled when
you select the attribute.

Supervisor Monthly
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.

Time Series Monthly
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.

VDN Summary Monthly
Name Description
Timezone The timezone for displaying results on the

document or report.
Date Filter The attributes to define the duration for displaying

results on the document or report.
Routing Point ID: Routing Point Name The name and ID of routing points. To filter results

on the document or report, you can move the
required routing points from the Available list to the
Selected list.

Note:
While running a report or document, hierarchical or cascaded prompts such as Agent Group-
Agent remain available in the Available list even after moving them to the Selected list.
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Input prompts page buttons
The following table lists the buttons on the input prompts page of each document:

Button Description
Run Document To generate the document.
Cancel To cancel generating the document.

Report summary page controls
The following actions are available on the report summary page depending on your permissions:

Action Description
Save To save a copy of the report.
Add to History List To send a report to the History List, to be saved for

future reference.
Create Personal View To create and save a personal view of the report

generated on a given date and time.
Share To share the report generated through an email link

or embedded report links in a web page.
Send Now To send a report to any email address.
Export To export the report in the required export format.

For example, Excel and PDF data formats.

Note:

HTML data format is currently not supported.
Print To print the report using Adobe Portable Document

Format (PDF).
Full Screen Mode To view the report summary page on the full screen.

Viewing a document based on interval data
About this task
Use this procedure to generate and view a document that uses a scheduled interval to generate
the data. These documents do not include data from the current 15-minute interval until you run
data aggregation for the interval. By default, the caching settings are set to 15 minutes.

Important:
To run a document, you must only use Supervisor credentials.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

Managing historical reports

November 2021 Using Avaya Analytics™ Reports for Avaya Oceana® 66
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Analytics™‎ Reports for Avaya Oceana®‎


3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. Click the required document.

For the list of available documents, see Standard Historical Reports page field
descriptions on page 20.

5. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

6. Click Run Document.

Avaya Analytics™ displays the document based on the input prompts.

The document provides the Interval option with the values 15 mins, Daily, Weekly,
Monthly, and Yearly. The default interval is 15 mins.

7. On the document, drill-down the required measure to obtain information about the
measure.

Document summary page controls
The following actions are available on the document summary page depending on your
permissions that you create for customization:

Action Description
Share To share the document generated through an email

link or embedded links in a web page.
Print To print the document using Adobe Portable

Document Format (PDF).
Export To export the document in the required export

format. For example, Excel and PDF data formats.

Note:

HTML data format is currently not supported.
Save To save a copy of the document.
Create Personal View To create and save a personal view of the

document generated on a given date and time.
Send Now To send a document to any email address.
Add to History List To send a document to the History List, to be saved

for future reference.
Schedule Delivery to History List To send a document to the History List page. This

page specifies a folder where you can store
documents on a specific schedule.

Refresh To refresh the data on the document.
Re-prompt To change the filter selection parameters.

Table continues…
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Action Description
Reset Selections To change the filter selection parameters within the

document that you generated.
Zoom (Fit Page) To zoom in and zoom out the page.
Edit To edit the document.

This option is available to users with specific
permissions.

Run as Editable Mode To run the document in an editable mode to make
the changes.

This option is available to users with specific
permissions.

Viewing a document with daily roll-up data
About this task
Use this procedure to generate and view a document that uses daily roll-up data to generate the
information. These documents do not include data for the current day, because the data is
calculated only the next day.

Important:
To run a document, you must only use Supervisor credentials.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. Click Daily.

5. On the Daily page, click the required document.

For the list of available documents, see Daily page field descriptions on page 23.

6. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

7. Click Run Document.

Avaya Analytics™ displays the document based on the input prompts.

The document provides the Interval option with the values Daily, Weekly, Monthly, and
Yearly. The default interval is Daily.

8. (Optional) To obtain information about the measure for the Account By Agent Daily report,
drill-down the required measure on the document.
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Document summary page controls
The following actions are available on the document summary page depending on your
permissions that you create for customization:

Action Description
Share To share the document generated through an email

link or embedded links in a web page.
Print To print the document using Adobe Portable

Document Format (PDF).
Export To export the document in the required export

format. For example, Excel and PDF data formats.

Note:

HTML data format is currently not supported.
Save To save a copy of the document.
Create Personal View To create and save a personal view of the

document generated on a given date and time.
Send Now To send a document to any email address.
Add to History List To send a document to the History List, to be saved

for future reference.
Schedule Delivery to History List To send a document to the History List page. This

page specifies a folder where you can store
documents on a specific schedule.

Refresh To refresh the data on the document.
Re-prompt To change the filter selection parameters.
Reset Selections To change the filter selection parameters within the

document that you generated.
Zoom (Fit Page) To zoom in and zoom out the page.
Edit To edit the document.

This option is available to users with specific
permissions.

Run as Editable Mode To run the document in an editable mode to make
the changes.

This option is available to users with specific
permissions.
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Viewing a document with monthly roll-up data
About this task
Use this procedure to generate and view a document that uses monthly roll-up data to generate
the information. These documents do not include data for the current month, because the data is
calculated only the next month.

Important:
To run a document, you must only use Supervisor credentials.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. Click Monthly.

5. On the Monthly page, click the required document.

For the list of available documents, see Monthly page field descriptions on page 24.

6. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. Click Run Document.

Avaya Analytics™ displays the document based on the input prompts.

The document provides the Interval option with the values Monthly and Yearly. The
default interval is Monthly.

8. (Optional) To obtain information about the measure for the Account By Agent Monthly
report, drill-down the required measure on the document.

Document summary page controls
The following actions are available on the document summary page depending on your
permissions that you create for customization:

Action Description
Share To share the document generated through an email

link or embedded links in a web page.
Print To print the document using Adobe Portable

Document Format (PDF).
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Action Description
Export To export the document in the required export

format. For example, Excel and PDF data formats.

Note:

HTML data format is currently not supported.
Save To save a copy of the document.
Create Personal View To create and save a personal view of the

document generated on a given date and time.
Send Now To send a document to any email address.
Add to History List To send a document to the History List, to be saved

for future reference.
Schedule Delivery to History List To send a document to the History List page. This

page specifies a folder where you can store
documents on a specific schedule.

Refresh To refresh the data on the document.
Re-prompt To change the filter selection parameters.
Reset Selections To change the filter selection parameters within the

document that you generated.
Zoom (Fit Page) To zoom in and zoom out the page.
Edit To edit the document.

This option is available to users with specific
permissions.

Run as Editable Mode To run the document in an editable mode to make
the changes.

This option is available to users with specific
permissions.

Viewing a Call Profile report dossier
About this task
Use this procedure to generate and view a Call Profile report dossier.

Important:
To run a document, you must only use Supervisor credentials.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.
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Avaya Analytics™ displays the Standard Historical Reports page.

4. Click Call Profile.

5. On the Call Profile page, click the required Call Profile report.

For the list of available reports, see Call Profile page field descriptions on page 26.

6. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 72.

7. Click Run Dossier.

Avaya Analytics™ displays the dossier based on the input prompts.

The dossier displays data for the following intervals: 15 mins, 30 mins, Hours, Daily,
Weekly, Monthly, and Yearly. The default interval is Weekly.

Input prompts
The following tables list the input prompts that you use to run a Call Profile dossier:

Name Description
Timezone The timezone for displaying results on the dossier.
Date Filter The attributes to define the duration for displaying

results on the dossier.
Routing Service Group - Routing Service Name The name of the routing service in a routing service

group that is used to route this contact to the agent.
To filter results on the document or report, you can
move the required routing service or routing service
group from theAvailable list to the Selected list. By
default, the Search for field option is disabled for
this prompt. However, this field gets enabled when
you select the attribute.

Dossier summary page controls
The following actions are available on the dossier summary page depending on your permissions:

Action Description
Save Save a copy of the dossier.
Refresh Refresh the data on the dossier.
Pause Data Retrieval Edit the dossier without retrieving data
Re-prompt Change the filter selection parameters.
Add Data Add new or existing data, such as existing datasets

or objects.
Export to PDF Export the dossier in PDF format.
Share Share the dossier generated through an email link

or embedded links in a web page.

Table continues…

Managing historical reports

November 2021 Using Avaya Analytics™ Reports for Avaya Oceana® 72
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Analytics™‎ Reports for Avaya Oceana®‎


Action Description
Print Print the document using Adobe Portable Document

Format (PDF).
Create Personal View Create and save a personal view of the dossier

generated on a given date and time.
Send Now Send a dossier to any email address.
Add to History List Send a dossier to the History List, to be saved for

future reference.
Schedule Delivery to History List Send a dossier to the History List page. This page

specifies a folder where you can store dossiers on a
specific schedule.

Reset Selections Change the filter selection parameters within the
dossier that you generated.

Zoom (Fit Page) Zoom in and zoom out the page.
Edit Edit the dossier.

This option is available to users with specific
permissions.

Run as Editable Mode Run the dossier in an editable mode to make
changes.

This option is available to users with specific
permissions.

Importing data from external datasources to create a report
Before you begin
You must be a basic or advanced user to perform this procedure.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > Add External Data.

The Connect to Your Data page opens.

3. To import data in the form of Excel, CSV, JSON, TEXT and SAS from your local machine,
do the following:

a. Click File from Disk.

b. Click Choose files and navigate to the file location.

You can also drag and drop files on this window from the folders of your local
machine.

c. Click Open.

4. Click Prepare Data to edit the data and add more tables.
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5. Click Finish.

Building a metric formula
About this task
Use this procedure to define your metric formula for analyzing data.

Note:
Only administrator or supervisor users can build a metric formula.

Procedure
1. Log on to Avaya Analytics™.

2. Click Create > New Metric.

The Metric Editor - New Metric page opens.

3. Click Switch to Formula Editor.
4. In the Metric Name, type a name for the new metric formula.

5. To build the formula, do the following:

a. From the All Functions drop-down, select the appropriate function, and double-click
the required sub-functions.

b. From the All Objects drop-down, select the objects required for the formula.

c. To use the mathematical operators in the formula, click the operators above the
formula editor.

d. Click Validate.

The formula is considered correct when the validation succeeds.

6. Click Save and navigate to the appropriate location, and click Save.

The metric formula is now available to all users as a shared metric.

Emailing a report
About this task
You can send a report to any email address.

Before you begin
Based on your requirements, ensure that you have the following privileges:

• Email any report.
• Send a report to the history list.
• Send a link to the report location in the history list through an email.
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Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For reports based on interval data, do the following:

a. Click Reports.

b. Click the required report.

To choose an appropriate report from the list of the available historical reports, see 
Reports page field descriptions on page 21.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For reports based on daily roll-up data, do the following:

a. Click Daily > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available daily historical reports,
see Reports page field descriptions on page 24.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For reports based on monthly roll-up data, do the following:

a. Click Monthly > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available monthly historical
reports, see Reports page field descriptions on page 25.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. On the report, in the Interval field, select the option according to the duration that you
specify in the Time Filter input prompt.

For example:

• If you specify an interval or a date in the Time Filter input prompt, you must select the 15
mins or Daily option in the Interval field.

• If you specify a week, a month, or a year in the Time Filter input prompt, you must select
the weekly, monthly, or yearly option in the Interval field.

8. Click Run Report.
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Avaya Analytics™ displays the report summary page based on the values specified in the
input prompts. You can further select the Interval, such as Daily, Weekly, Monthly, Yearly,
from the report page.

9. On the report, click the hamburger icon ( ), and click Send Now.

10. To locate the recipient's email address, click To.

Avaya Analytics™ displays the Available list of recipients from your address list in the
Recipients Browser window.

11. Select the email address from the Available list and click OK.

a. If you cannot find the email address in the list, enter the recipient's name and email
address in the Address Name and Physical Address fields, respectively.

b. Click Add To Recipients to add the new address.

The new email address displays in the To field.

c. Click OK to return to the Send Now page.

12. In the Send field, select one of the following options to specify how to send the report:

• Data in email: The email displays the report.

• Data in email and to history list: The email displays the report and is also delivered to
the History List page.

• Data and link to history list in email: The email displays the report and a link to the
History List page.

• Link to history list in email: The email includes a link to the History List page.

13. In the Delivery Format field, select one of the following formats to send the report:

• PDF: To deliver the report in Adobe Portable Document Format (PDF).

• Excel: To deliver the report in Microsoft Excel format.

• Plain Text: To deliver the report in Rich Text Format.

• CSV: To deliver the report in the Comma Separated Values file.

Note:

HTML data format is currently not supported.

Important:

To email a report, you can also click the Send Now link on the report icon.

14. (Optional) If you select PDF and your report has multiple pages, do the following:

a. Click PDF Settings.

The Export PDF window appears.

b. In the Range field, select Entire Dossier.
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c. In the Detail Level field, select Each visualization as a page.

d. Click Save.

15. Use the Burst option to send out personalized parts of a single report execution to a
dynamic list of recipients.

16. In the Subject field, type a description for the report.

17. In the Message field, type the message to be emailed with the report.

18. To include the report in a zip file, do the following:

a. Expand Advanced Options.

b. Select the Password Protect Zip File check box to protect the zip file by providing a
password.

c. Type a password for the zip file.

d. In the Zip File Name field, type the name for the zip file.

19. Click OK.

Avaya Analytics™ sends the report to the specified email address.

Emailing a document
About this task
You can send a document to any email address.

Before you begin
Based on your requirements, ensure that you have the following privileges:

• Privilege to send a document to the history list.
• Privilege to send a link to the location of a document in the history list through an email.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For documents based on interval data, do the following:

a. Click the required document.

To choose an appropriate document from the list of the available documents, see 
Standard Historical Reports page field descriptions on page 20.

b. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.
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5. For documents based on daily roll-up data, do the following:

a. Click Daily.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Daily page field descriptions on page 23.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For documents based on monthly roll-up data, do the following:

a. Click Monthly.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Monthly page field descriptions on page 24.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. On the document, in the Interval field, select the option according to the duration that you
specify in the Time Filter input prompt.

For example:

• If you specify an interval or a date in the Time Filter input prompt, you must select the 15
mins, Daily, or Monthlyoption in the Interval field.

• If you specify a week, a month, or an year in the Time Filter input prompt, you must
select the weekly, monthly, or yearly option in the Interval field.

8. Click Run Document.

Avaya Analytics™ displays the document summary page based on the values specified in
the input prompts. You can further select the Interval, such as Daily ,Weekly, Monthly,
Yearly, from the document page.

9. On the document, click the hamburger icon ( ), and then click Send Now.

10. To locate the recipient's email address, click To.

Avaya Analytics™ displays the Available list of recipients from your address list in the
Recipients Browser window.

11. Select the email address from the Available list and click OK.

a. If you cannot find the email address in the list, enter the recipient's name and email
address in the Address Name and Physical Address fields, respectively.

b. Click Add To Recipients to add the new address.

The new email address displays in the To field.

c. Click OK to return to the Send Now page.
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12. In the Send field, select one of the following options to specify how to send the document:

• Data in email: The email displays the document.

• Data in email and to history list: The email displays the document and is also
delivered to the History List page.

• Data and link to history list in email: The email displays the document, along with a
link to the History List page.

• Link to history list in email: The email includes a link to the History List page.

13. In the Delivery Format field, select one of the following formats to send the document:

• Excel: To deliver the document in Microsoft Excel format.

• PDF: To deliver the document in Adobe Portable Document Format (PDF).

Note:

HTML data format is currently not supported.

Important:

You can also email a document by clicking the Send Now icon on the document icon.

14. Use the Burst option to send out personalized parts of a single report execution to a
dynamic list of recipients.

15. In the Subject field, type a description for the document.

16. In the Message field, type the message to be emailed along with the document.

17. To include the document in a zip file, do the following:

a. Expand Advanced Options.

b. Select the Password Protect Zip File check box to protect the zip file by providing a
password.

c. Type a password for the zip file.

d. In the Zip File Name field, type the name for the zip file.

18. Click OK.

Avaya Analytics™ sends the document to the specified email address.

Emailing a dossier
About this task
You can send a dossier to any email address.
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Before you begin
Based on your requirements, ensure that you have the following privileges:

• Email any dossier.
• Send a dossier to the history list.
• Send a link to the location of a dossier in the history list through an email.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. In the content pane, click Call Profile.

5. Complete the following steps for a dossier based on call profile data:

a. Click the required dossier.

To select an appropriate call profile dossier, see Chapter 9: Call Profile Reports.

b. Specify the values on the input prompts.

For more information about input prompts, see Input prompts on page 72.

6. On the dossier, select the Start Date and End Date according to the duration that you
specify in the Time Filter input prompt.

For example, to view the number of calls related to your routing services in a given quarter,
you can use the time filters to select the months of the quarter.

7. Click Run Dossier.

Avaya Analytics™ displays the dossier summary visualizations based on the values
specified in the input prompts.

8. On the dossier page, click the File menu and then click Send Now.

9. In the Send field, select one of the following options to specify how to send the dossier:

• Data in email: The email displays the dossier.

• Data in email and to history list: The email displays the dossier and is also delivered
to the History List page.

• Data and link to history list in email: The email displays the dossier, along with a link
to the History List page.

• Link to history list in email: The email includes a link to the History List page.

10. In the Delivery Format field, select one of the following formats to send the dossier:

• PDF: To deliver the dossier in Adobe Portable Document Format (PDF).

• MSTR: To deliver the dossier in Historical Reporting (.mstr) format.
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11. Click PDF Settings and complete the following steps to change the PDF page formatting
for the dossier:

a. In the Range field, select from the following options:

• This Page: Current page

• This Chapter: Current chapter

• Entire Dossier: Entire dossier

b. In the Detail Level field, select from the following options:

• Full page views: Exports a snapshot of each page and each individual
visualization

• Each visualization as a page: Exports full details of individual visualizations

• Both
c. In the Grid Settings field, select from the following options:

• Scale to page width: Fits the grid's width onto one PDF page width

• Extend colums over pages: Breaks a wide grid onto numerous pages

12. In the Subject field, type a description for the dossier.

13. In the Message field, type the message to be emailed along with the dossier.

14. To include the report in a zip file, do the following:

a. Expand Advanced Options.

b. Select the Password Protect Zip File check box to provide a password to protect the
zip file.

c. Type a password for the zip file.

d. In the Zip File Name field, type the name for the zip file.

15. Click OK.

Avaya Analytics™ sends the dossier to the specified email address.

Exporting a report
About this task
You can export a whole report or the first report page from the Avaya Analytics™ interface. Using
the export option, you can export report title or filter details. You can also edit the custom settings
of your report. If you export reports in Excel, you can export metric values and headers as texts
and embed all images.

Procedure
1. Log on to Avaya Analytics™.
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2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For reports based on interval data, do the following:

a. Click Reports.

b. Click the required report.

To choose an appropriate report from the list of the available historical reports, see 
Reports page field descriptions on page 21.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For reports based on daily roll-up data, do the following:

a. Click Daily > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available daily historical reports,
see Reports page field descriptions on page 24.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For reports based on monthly roll-up data, do the following:

a. Click Monthly > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available monthly historical
reports, see Reports page field descriptions on page 25.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. Click Run Report.

Avaya Analytics™ displays the report summary page based on the values specified in the
input prompts. You can further select the Interval, such as Daily, Weekly, Monthly, Yearly,
from the report page.

8. On the report, click the hamburger icon ( ), and then click Export.
9. Select the required export format.

The export formats are Excel, CSV, PDF, and plain text.

Note:

HTML data format is currently not supported.
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Important:

You can also export a report or document by clicking the Export option on the report
icon.

Exporting a document
About this task
You can export a document in different file formats.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For documents based on interval data, do the following:

a. Click the required document.

To choose an appropriate document from the list of the available documents, see 
Standard Historical Reports page field descriptions on page 20.

b. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For documents based on daily roll-up data, do the following:

a. Click Daily.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Daily page field descriptions on page 23.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For documents based on monthly roll-up data, do the following:

a. Click Monthly.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Monthly page field descriptions on page 24.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.
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7. Click Run Document.

Avaya Analytics™ displays the report summary page based on the values specified in the
input prompts. You can further select the Interval, such as Daily ,Weekly, Monthly, Yearly,
from the report page.

8. On the document, click the hamburger icon ( ), and then click Export.
9. Select the required export format.

The export formats are Excel and PDF.

Note:

HTML data format is currently not supported.

Important:

You can also export a document by clicking the Export option on the document icon.

Exporting a dossier
About this task
You can export a dossier to PDF format from the Avaya Analytics™ interface. Complete the
following steps to export a dossier:

Note:
The Export to PDF settings in this procedure are specific to Call Profile dossier reports.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. In the content pane, click Call Profile.

5. Complete the following steps for a dossier based on call profile data:

a. Click the required dossier.

To select an appropriate call profile dossier, see Chapter 9: Call Profile Reports.
b. Specify the values on the input prompts.

For more information about input prompts, see Input prompts on page 72.

6. On the dossier, select the Start Date and End Date according to the duration that you
specify in the Time Filter input prompt.

For example, to view the number of calls related to your routing services in a given quarter,
you can use the time filters to select the months of the quarter.
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7. Click Run Dossier.

Avaya Analytics™ displays the dossier summary visualizations based on the values
specified in the input prompts.

8. On the dossier, click the File menu and then click Export to PDF.

9. Complete the following steps in the Export to PDF window:

a. In the Range field, select from the following options:

• This Page: Current page

• This Chapter: Current chapter

• Entire Dossier: Entire dossier

b. In the Detail Level field, select from the following options:

• Full page views: Exports a snapshot of each page and each individual
visualization

• Each visualization as a page: Exports full details of individual visualizations

• Both
c. In the Grid Settings field, select from the following options:

• Scale to page width: Fits the grid's width onto one PDF page width

• Extend colums over pages: Breaks a wide grid onto numerous pages

10. Click Export.

Avaya Analytics™ exports the dossier to PDF.

Scheduling a report
About this task
Use this procedure to create a schedule for a report. When you create a schedule for a report,
Avaya Analytics™ generates the report based on the schedule and saves it in the History List.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For reports based on interval data, do the following:

a. Click Reports.

b. Click the required report.
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To choose an appropriate report from the list of the available historical reports, see 
Reports page field descriptions on page 21.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For reports based on daily roll-up data, do the following:

a. Click Daily > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available daily historical reports,
see Reports page field descriptions on page 24.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For reports based on monthly roll-up data, do the following:

a. Click Monthly > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available monthly historical
reports, see Reports page field descriptions on page 25.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. Click Run Report.

Avaya Analytics™ generates the report based on the input prompts.

8. Click the hamburger icon ( ) and click Schedule Delivery to History List.
9. In the Name field, type a name for the new report schedule.

The Report field displays the name of the report.

10. In the Schedule field, select a schedule or event on which the report must be delivered.

11. Click To to add more recipients for the subscription.

12. To get the report delivered immediately after creating the subscription, select the Run
subscription immediately check box.

13. In Advanced Options, click the plus icon to do the following:

a. To ensure that newer versions of the report overwrite previous versions on the History
List page, select the The new scheduled report will overwrite older versions of
itself check box.

b. To specify a date after which the report delivery must be stop, select the Do not
deliver after check box, and select the date from the calendar.

14. To have a notification email sent to the sender after the report delivery, select the Send
notification to email address check box.
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15. Click OK.

Scheduling a document
About this task
When you create a schedule for a document, Avaya Analytics™ generates the document based on
the schedule and saves it in the History List.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For documents based on interval data, do the following:

a. Click the required document.

To choose an appropriate document from the list of the available documents, see 
Standard Historical Reports page field descriptions on page 20.

b. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For documents based on daily roll-up data, do the following:

a. Click Daily.
b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Daily page field descriptions on page 23.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For documents based on monthly roll-up data, do the following:

a. Click Monthly.
b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Monthly page field descriptions on page 24.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. Click Run Document.

Avaya Analytics™ displays the document summary page based on the values specified in
the input prompts.
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8. Click the hamburger icon ( ) and click Schedule Delivery to History List.
9. In the Name field, type a name for the new document schedule.

The Document field displays the name of the document.

10. In the Schedule field, select a schedule or event on which the document must be
delivered.

11. Click To to add more recipients for the subscription.

12. For the preview of the document, in the Pre-generate export drop-down, select, PDF or
Excel.

The default option is None.

13. To get the document delivered immediately after creating the subscription, select the Run
subscription immediately check box.

14. In Advanced Options, click the plus icon to do the following:

a. To ensure that newer versions of the document overwrite previous versions on the
History List page, select the The new scheduled report will overwrite older
versions of itself check box.

b. To specify a date after which the document delivery must stop, select the Do not
deliver after check box, and select the date from the calendar.

15. To have a notification email sent to the sender after the document delivery, select the Send
notification to email address check box.

16. Click OK.

Scheduling a dossier
About this task
Use this procedure to create a schedule for a dossier. When you create a schedule for a dossier,
Avaya Analytics™ generates the dossier based on the schedule and saves it in the History List.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. In the content pane, click Call Profile.

5. Complete the following steps for a dossier based on call profile data:

a. Click the required dossier.

To select an appropriate call profile dossier, see Chapter 9: Call Profile Reports.
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b. Specify the values on the input prompts.

For more information about input prompts, see Input prompts on page 72.

6. On the dossier, select the Start Date and End Date according to the duration that you
specify in the Time Filter input prompt.

For example, to view the number of calls related to your routing services in a given quarter,
you can use the time filters to select the months of the quarter.

7. Click Run Dossier.

Avaya Analytics™ displays the dossier summary visualizations based on the values
specified in the input prompts.

8. On the dossier page, click the File menu and then click Schedule Delivery to History
List.

9. In the Name field, type a name for the new dossier schedule.

The Dossier field displays the name of the dossier.

10. In the Schedule field, select a schedule or event on which you want to deliver the dossier.

11. Click To to add more recipients for the subscription.

12. In the Delivery Format field, select one of the following formats to send the dossier:

• PDF: To deliver the dossier in Adobe Portable Document Format (PDF).

• MSTR: To deliver the dossier in Historical Reporting (.mstr) format.

13. Click PDF Settings to change the PDF page formatting for the dossier.

a. In the Range field, select from the following options:

• This Page: Current page

• This Chapter: Current chapter

• Entire Dossier: Entire dossier

b. In the Detail Level field, select from the following options:

• Full page views: Exports a snapshot of each page and each individual
visualization

• Each visualization as a page: Exports full details of individual visualizations

• Both
c. In the Grid Settings field, select from the following options:

• Scale to page width: Fits the grid's width onto one PDF page width

• Extend colums over pages: Breaks a wide grid onto numerous pages

14. Select the Run subscription immediately check box to get the dossier delivered
immediately after creating the subscription.
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15. In Advanced Options, click the plus icon to complete the following steps:

a. Select the The new scheduled report will overwrite older versions of itself check
box to ensure that newer versions of the dossier overwrite previous versions on the
History List page.

b. Select the Do not deliver after check box and select the date from the calendar to
specify a date after which the dossier delivery must stop.

16. Select the Send notification to email address check box to have a notification email sent
to the sender after the dossier delivery.

17. Click OK.

Printing a report
About this task
For printing a report, you must use Adobe Reader 6.0 or later.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For reports based on interval data, do the following:

a. Click Reports.

b. Click the required report.

To choose an appropriate report from the list of the available historical reports, see 
Reports page field descriptions on page 21.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For reports based on daily roll-up data, do the following:

a. Click Daily > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available daily historical reports,
see Reports page field descriptions on page 24.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.
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6. For reports based on monthly roll-up data, do the following:

a. Click Monthly > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available monthly historical
reports, see Reports page field descriptions on page 25.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. Click Run Report.

Avaya Analytics™ generates the report based on the input prompts.

8. On the menu bar, click the Print icon.

9. On the Print options page, enter the desired values and click Show Printable Version.

10. On the Reports page, click the Print icon.

Printing a document
About this task
For printing a document, you must use Adobe Reader 6.0 or later.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For documents based on interval data, do the following:

a. Click the required document.

To choose an appropriate document from the list of the available documents, see 
Standard Historical Reports page field descriptions on page 20.

b. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For documents based on daily roll-up data, do the following:

a. Click Daily.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Daily page field descriptions on page 23.
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c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For documents based on monthly roll-up data, do the following:

a. Click Monthly.

b. Click the document.

To choose an appropriate document from the list of the available documents, see 
Monthly page field descriptions on page 24.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. Click Run Document.

Avaya Analytics™ displays the report summary page based on the values specified in the
input prompts.

8. On the report page, click the hamburger icon ( ).

9. Click Print.

Printing a dossier
Procedure

1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. In the content pane, click Call Profile.

5. Complete the following steps for a dossier based on call profile data:

a. Click the required dossier.

To select an appropriate call profile dossier, see Chapter 9: Call Profile Reports.

b. Specify the values on the input prompts.

For more information about input prompts, see Input prompts on page 72.

6. On the dossier, select the Start Date and End Date according to the duration that you
specify in the Time Filter input prompt.

For example, to view the number of calls related to your routing services in a given quarter,
you can use the time filters to select the months of the quarter.

7. Click Run Dossier.

Managing historical reports

November 2021 Using Avaya Analytics™ Reports for Avaya Oceana® 92
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Analytics™‎ Reports for Avaya Oceana®‎


Avaya Analytics™ displays the dossier summary visualizations based on the values
specified in the input prompts.

8. On the dossier page, click the File menu and then click Print.

The visualization page opens in a preview pane.

9. Select one of the following options from the Destination dropdown menu:

• Save as PDF
• Select a printer
• See more

10. Click Print/Save.

11. Repeat steps 9 and 10 for the remaining pages in the dossier.

Subscribing to a report
About this task
You can subscribe to any report to receive updated copies of that report in the chosen format.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For reports based on interval data, click Reports.

5. For reports based on daily roll-up data, click Daily > Report.
6. For reports based on monthly roll-up data, click Monthly > Report.
7. On the reports list page, under the name of the report for which you want to create a

subscription, do one of the following:

• In the Large Icons view, click the Subscriptions link below the icon of the report.

• In the List view, click the Subscriptions icon ( ) in the Actions column.

8. Click Add <the type of the subscription> subscription.

For information about the type of subscriptions, see Subscription of reports on page 16.

9. In the Name field, type a name for the subscription.

The Document field displays the name of the document.

10. In the Schedule field, select a schedule from the drop-down list for the subscription.

11. Click To to add more recipients for the subscription.
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12. Select the Run subscription immediately option.

13. Expand Advanced Options and complete the following steps as required:

a. Select or deselect the The new scheduled report will overwrite older versions of
itself option.

This option is selected by default.

b. Under Delivery, select the Do not deliver after option and set a date after which you
do not want delivery of the document.

14. In the Delivery Notification section, select the Send notification to email address
option and enter the email address in the New Address field.

15. Click OK.

Subscribing to a document
About this task
You can subscribe to any document to receive updated copies of that document in the chosen
format.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For documents based on interval data, click the document.

5. For documents based on daily roll-up data, click Daily.

6. For documents based on monthly roll-up data, click Monthly.

7. On the reports list page, under the name of the document for which you want to create a
subscription, do one of the following:

• In the Large Icons view, click the Subscriptions link below the icon of the report.

• In the List view, click the Subscriptions icon ( ) in the Actions column.

8. Click Add <the type of the subscription> subscription.

For information about the type of subscriptions, see Subscription of reports on page 16.

9. In the Name field, type a name for the subscription.

The Document field displays the name of the document.

10. In the Schedule field, select a schedule from the drop-down list for the subscription.

11. Click To to add more recipients for the subscription.
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12. Select the Run subscription immediately option.

13. Expand Advanced Options and complete the following steps as required:

a. Select or deselect the The new scheduled report will overwrite older versions of
itself option.

This option is selected by default.

b. Under Delivery, select the Do not deliver after option and set a date after which you
do not want delivery of the document.

14. In the Delivery Notification section, select the Send notification to email address
option and enter the email address in the New Address field.

15. Click OK.

Subscribing to a dossier
About this task
You can subscribe to any dossier to receive updated copies of that dossier in the chosen format.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. In the content pane, click Call Profile.

5. Click the required dossier.

To select an appropriate call profile dossier, see Chapter 9: Call Profile Reports.

6. On the dossier list page, under the name of the dossier for which you want to create a
subscription, do one of the following:

• In the Large Icons view, click the Subscriptions link below the icon of the report.

• In the List view, click the Subscriptions icon in the Actions column.

7. Click Add to add the type of subscription.

For information about the type of subscriptions, see Subscription of reports on page 16.

8. In the Name field, type a name for the subscription.

The Dossier field displays the name of the dossier.

9. In the Schedule field, select a schedule from the list for the subscription.

10. Click To to add more recipients for the subscription.
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11. In the Delivery Format field, select one of the following formats to send the dossier:

• PDF: To deliver the dossier in Adobe Portable Document Format (PDF).

• MSTR: To deliver the dossier in Historical Reporting (.mstr) format.

12. Click PDF Settings to change the PDF page formatting for the dossier.

a. In the Range field, select from the following options:

• This Page: Current page

• This Chapter: Current chapter

• Entire Dossier: Entire dossier

b. In the Detail Level field, select from the following options:

• Full page views: Exports a snapshot of each page and each individual
visualization

• Each visualization as a page: Exports full details of individual visualizations

• Both
c. In the Grid Settings field, select from the following options:

• Scale to page width: Fits the grid's width onto one PDF page width

• Extend colums over pages: Breaks a wide grid onto numerous pages

13. Select the Send a preview now checkbox to send a preview immediately.

14. In the Subject field, type a description for the dossier.

15. In the Message field, type the message to be emailed along with the dossier.

16. To include the report in a zip file, do the following:

a. Expand Advanced Options.

b. Select the Password Protect Zip File check box to provide a password to protect the
zip file.

c. Type a password for the zip file.

d. In the Zip File Name field, type the name for the zip file.

e. Select the Do not deliver after check box and select the date from the calendar, to
specify a date after which the dossier delivery must stop.

17. Click OK.

Avaya Analytics™ sends the dossier to the specified email address.

Unsubscribing a document or report
About this task
Complete the following steps to unsubscribe a document or report:
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Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, click My Subscriptions or click My Subscriptions in the left
navigational pane.

3. On the My Subscriptions page, in the Unsubscribe column, select the check box of the
document or report that you want to unsubscribe.

4. Click the Unsubscribe column header.

The selected document or report is removed from the Subscriptions list.

Setting thresholds
About this task
Using thresholds, you can draw immediate attention to data based on evaluations. For example,
you can set thresholds to highlight rows in red for display values that are greater than 10. You can
add thresholds in design mode only.

Important:
To run a report, you must only use Supervisor credentials.

Procedure
1. Log on to Avaya Analytics™.

2. On the Home page, in the navigation pane, click Shared Reports.

3. In the content pane, click Standard Historical Reports.

Avaya Analytics™ displays the Standard Historical Reports page.

4. For reports based on interval data, do the following:

a. Click Reports.

b. Click the required report.

To choose an appropriate report from the list of the available historical reports, see 
Reports page field descriptions on page 21.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 54.

5. For reports based on daily roll-up data, do the following:

a. Click Daily > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available daily historical reports,
see Reports page field descriptions on page 24.
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c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 59.

6. For reports based on monthly roll-up data, do the following:

a. Click Monthly > Reports.

b. Click the required report.

To choose an appropriate report from the list of the available monthly historical
reports, see Reports page field descriptions on page 25.

c. On the input prompts, specify the values.

For information about input prompts, see Input prompts on page 63.

7. Click Run Report.

Avaya Analytics™ generates the report based on the input prompts.

8. On the report, right-click on a metric and click Thresholds.

9. Select one of the following options:

• Visual

In the Visual Threshold Editor, you can specify the condition by defining different ranges
of values. You can then specify the formatting to automatically apply to data that falls
into these ranges.

• Advanced

In the Advanced Threshold Editor, you can format data in a visualization based on
multiple attribute or metric qualifications.

10. To set visual thresholds, provide the required value.

11. To set advanced thresholds, select the required options and provide the value.

Creating a report, document, or dossier from external data
About this task
In Avaya Analytics™, Basic and Advanced users create a report, document, or dossier with data
from external files, such as Excel, JSON, or CSV files saved in your machine. You can blend the
data with Avaya Analytics™ data or use the externally sourced data.

Procedure
1. Log on to Avaya Analytics™.

2. From the navigation bar on the left, click Create > Add External Data.

Avaya Analytics™ displays the Connect to Your Data page.
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3. To import data from files on your local machine, do the following:

a. Click File from Disk.

b. On the Upload your files page, click Choose files.

c. Choose your files and click Open.

d. (Optional) To edit the data before importing, click Prepare Data.

Edit the data as required in the Data Prepare box.

e. Click Finish.

Avaya Analytics™ displays the Save As window.

4. To save the file in your desired location, in the Save in field, click the location.

5. (Optional) In the Name field, you can change the name of the file.

6. (Optional) In the Description field, enter the description for future reference.

7. (Optional) To create a new folder to save the file, click Create New Folder.
8. Click Save.

Avaya Analytics™ displays the Start your analysis page.

9. Depending on your requirement, click one of the following:

• Create Dossier
• Create Document
• Create Report

The document opens in the Design mode with the metrics and attributes available in the
selected data source.

10. Drag and drop the Attributes and Metrics to the right panel to create a new report
document.

Avaya Analytics™ displays the adhoc report from the external data source.

Creating database connections to an external database
About this task
In Avaya Analytics™, advanced users can create connections to the popular external databases for
importing data. You can use the data to create reports and documents.
You can define a new database connection directly from Avaya Analytics™ for users to import data,
edit, delete, rename, or duplicate an existing connection.

Before you begin
Ensure the following:

• Get advanced user credentials.
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• Create a data source with Data Source Name (DSN) if you plan to connect to a data source
using a DSN.

Note:
You can also use the DSNLess Connection option to connect to your data source.

Procedure
1. Log on to Avaya Analytics™ with your advanced user credentials.

2. From the navigation bar on the left, click Create > Add External Data.

Note:

A basic user can get access to only the data files from the local machine, such as
excel files, CSV, JSON files. An advanced user can get access to data from external
databases.

Avaya Analytics™ displays the Connect to Your Data page.

3. Click Databases and select the database that you want to connect to, such as Microsoft
SQL (MS SQL) database.

The Select Import Options page pops up and displays the following options:

• Build a Query
• Type a Query
• Select Tables

4. Depending of the type of data you want to import, click one of the following options:

• To use a graphical interface to build the SQL query to use to import your data, click the
Build a Query button.

• To manually type or paste a query to import your data, click the Type a Query button.

• To select tables in the data for the import, click the Select Tables button.

5. Click Next.
6. To create a new data source, click the plus icon next to DATA SOURCES.

The Data Source page pops up.

7. Select the type of connection to the database using one of the following options:

• DSN Data Sources

• DSN-less Data Sources

8. Depending on the database connection you choose, enter the details in the fields and click
Save.

9. To test the connection, return to Import from the <import options> page and ensure that
the page displays the information.

Here <import options> refers to any of the data types you choose to import, such as tables.
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Exporting web objects
About this task
In Avaya Analytics™, you can export web objects to archive all reports during an upgrade.

Warning:
Do not export canned reports. Exporting these reports between releases or patches can
overwrite all fixes delivered in a release or a patch.

Before you begin
Create a folder on your local machine to save the exported files.

Procedure
1. Log on to Avaya Analytics™.

Note:

Log in as administrator if you want to export a large number of reports at the folder
level.

2. To export reports from the Custom Reports folder, click Shared Reports > Custom
Reports.

3. To export standard historical reports, click Shared Reports > Standard Historical
Reports.

4. To export interval based reports, click Shared Reports > Standard Historical Reports >
Reports.

5. To export reports based on daily data, click Shared Reports > Standard Historical
Reports > Daily > Reports.

6. To export reports based on monthly data, click Shared Reports > Standard Historical
Reports > Monthly > Reports.

7. Right-click the folder and click Export to MMP.

Avaya Analytics™ downloads the migration package to the designated folder on your
machine. This package contains the objects and their dependencies.

8. Follow the same procedure for exporting individual reports or documents from any of these
folders.

Importing web objects
About this task
In Avaya Analytics™, administrators can import a custom mmp file, such as a custom report, that
other users create to generate historical reports.
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Important:
You must refresh your browser after a successful import.

Before you begin
Create a folder on your local machine to save the imported files.

Procedure
1. Log in to Avaya Analytics™ as Administrator.

2. Click Shared Reports or My Reports.

3. On the left navigation bar, click Import Migration Package.

4. In the Import a Migration Package page, click Choose File.

5. To import the selected file, click Import.

Avaya Analytics™ downloads an file in the designed folder on your machine.

Next steps
Refresh your browser.
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Chapter 6: Historical reports summary
overview

Using historical reports based on interval data, you can generate reports for a week, month, or year
based on the current interval. All historical summary and trend reports that return interval-based
measures do not include data from the current 15-minute interval until data aggregation is run for
the interval. By default, report caching settings are set to 15 minutes. Therefore, you might need to
wait for up to 30 minutes for the data of the current interval to display in the report.

Note:

The maximum data retention period for these reports is 12 months. This data retention period is
configurable.

The historical reports based on interval data available in Avaya Analytics™ are:

• Account By Agent

• Agent By Routing Service

• Agent Configuration

• Agent Login/Logout Report

• Agent Not Ready by Reason Code

• Agent Performance Summary

• Contact Center

• Engagement

• Contact Detail

• Messaging Engagement Summary

• Routing Service

• Supervisor

• Time Series

• VDN

For more detailed information about the measures, data, and reports that Avaya Analytics™

provides, see Avaya Analytics™ Data Dictionary available from the Avaya Support website at https://
support.avaya.com.
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This chapter provides a summary of the historical reports that are based on interval data, such as
how each report works and the respective business usage.

Account by Agent Summary
Definition
Displays a summary of agents who handled the contacts for the accounts during the current
interval.

How it works
Tracks the performance of the contact center agents by account for the current interval. Intervals
are aggregated by 15 minutes and can be either an Interval, Daily, Weekly, Monthly or Yearly.
Supervisors can select the agents to report on and analyze the performance of agents serving the
accounts for the selected interval.
This report displays the accounts, their attributes, and the channels through which a contact is
routed.
You can drill down on an agent to view the Agent Details report. This report provides agent
performance at a detail level.
You can drill down on Abandoned, Completed, Conferenced, Offered, Transferred, Not Answered,
Consulted, and Number of Holds measures to view the Agent Interaction report. This report
provides agent interactions for the selected measure.

Business usage
• How many contacts were offered to the agent and for which accounts for the current interval?

Use the Offered measure to determine the number of contacts offered to the agent. Use the
Account ID measure to determine the accounts serviced by the agent.

• How many accounts did the agent service for the current interval?
Use the Account ID measure to determine the accounts that the agent serviced.

• How do you determine the usage of channels by agent for the reporting period?
Use the Channel measure to determine the number of channels that the agent supported
while supporting an account. Use the Active Time measure to determine the active time
spent by the agent for the selected channel.

• How do you determine the occupancy rate of the agent for each account for the selected
interval?
Use the Account ID measure to determine the accounts that the agent supported the most.
Use the Average Active Time measure to determine the active time spent by the agent for
the accounts.

• How many accounts did the agent support on each channel, and how much time did the
agent spend on each account for the current interval?
Drill down on the agent to Agent Details. Use the Account ID and Account Name
measures to determine the accounts that the agent supported on each channel. Use the
Active Time measure to determine the time spent by the agent on each account.
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• How do you determine the performance of the agent for the current interval?
Drill down on the agent to Agent Details. Compare the % Availability with the Average
Active Time measure to determine the performance of an agent.

• How do you view a snapshot of the agent performance across accounts?
Drill down on the agent to Agent Details. Use the Accounts by Agent Counts View to
determine the agent performance for all the accounts that the agent supported.

• How do you determine the reason for the segment type of a call?
Drill down to Agent Interaction Details report. Use the Segment Type measure to
determine the reason of the segment type of a call.

• How do you determine whether the supervisor has barged-out the agent from the call?
Drill down to Agent Interaction Details report. Use the Barged Out Indicator measure to
determine whether the supervisor has removed the agent from the call.

Agent By Routing Service
Definition
Displays how agents use routing services for the current interval.

How it works
Tracks the performance of agents by channels associated with the routing services for the current
interval. Intervals are aggregated by 15 minutes and can be Daily, Weekly, Monthly, and Yearly.
Supervisors can select the routing services within a routing service group for reporting and track
the channels' historical performance. Supervisors can only view routing services and routing
service measures associated with the routing service group to which they are assigned.
You can drill down on Offered, Abandoned, Answered, Transferred, and Consults measures to
view the Agent Interaction Detail report. This report provides agent interactions for the selected
measure.

Business usage
• How do you determine an agent’s performance by routing service for the current interval?

You can determine an agent's performance by analyzing the data in the agent's Offered,
Abandoned, Answered, Transferred, and Consults measures.

• How do you determine the usage of channels by an agent for the current interval?
You can create a report by selecting the required routing service and corresponding
channels. In the report, you can select the channels and determine the usage of each
channel by the agent.

• How do you compare the performance of agents by routing services for the current interval?
Use the Offered and Answered measures to determine the number of engagements
directed and answered. Use the Number of Holds measure to determine the number of
times that the engagements were put on hold by the agent.

Agent By Routing Service
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• How do you determine the usage of routing services for the current interval?
Generate reports using different intervals. Analyze the usage pattern of routing services and
associated channels for different intervals to gain an insight on the usage pattern of the
routing services.

• How do you determine the reason for the segment type of a call?
Drill down to Agent Interaction Details report. Use the Segment Type measure to
determine the reason of the segment type of a call.

• How do you determine whether the supervisor has barged-out the agent from the call?
Drill down to Agent Interaction Details report. Use the Barged Out Indicator measure to
determine whether the supervisor has removed the agent from the call.

• How do you interpret Transferred drill down value from Agent By Routing Service report?
As count of transfers initiated or answered by agent within the reporting period. After drilling
down from Transferred value into Agent Interaction Details report, the number of segments
displayed is generally equal to the value clicked. When the agent accepts transfer and
transfers it again, the Transferred value is equal to 2 and only one agent segment is created.
This is design intent.

• How do you compare the performance of agents on different parameters in the routing
service for the current interval?
Select the agents that you want to compare. Then, select the various measures and intervals
to view data of the selected agents. For example, use the Offered and Answered measures
to determine the number of engagements directed and answered. Use the Number of Holds
measure to determine the number of times that the engagements were put on hold by the
agent.

Agent Configuration
Definition
Displays agent information and agent properties.

How it works
Supervisors can view this report to understand the properties configured for the agent. Properties
include channels assigned to the agent and the number of engagements per channel that the
agent can handle. You can click on an Agent ID to view Agent Attributes.

Business usage
• How do I determine the channels assigned to the agent?

Use the Channel ID measure to understand the channels assigned to the agent.
• How do I determine the number of concurrent contacts that can be active on an account?

Use the Multiplicity measure to determine the concurrent contacts that can be active on an
account.
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• How do I determine the routing attributes for an agent?
On the Agent Configuration report, click on the agent. On the Agent Configuration
Attributes, use the Attribute measure to determine the routing attributes for the agent.

Agent Login/Logout Summary
Definition
Displays agent login and logout information

How it works
Supervisors can view this report to see each login and logout event for each agent, as well as the
log on duration for each session.

Business usage
Allows a supervisor to monitor the login and logout behavior of their agents:

• How often do my agents log in or out?
Each log in and log out event is recorded in the report. Therefore, the supervisor can check
the number of times an agent logs in or logs out on a Daily, Weekly, Monthly or Yearly basis.

• How long do my agents spend logged in?
Use the Agent Logon Duration measure to see how long the agent spent logged in during
that session.

• How do I see the status of my agent’s logon?
Add the custom Status column to the Agent Login/Logout report.

• How do I see if my agents are currently logged in?
If an agent is currently logged in, the Logon TIMESTAMP WITH TIMEZONE measure is
filled in on the report, but the Logout TIMESTAMP WITH TIMEZONE and Logon Duration
measures are not filled. The custom Status measure shows the value 0, which specifies that
the agent is currently working.

• What is the maximum data retention period for the Agent Login/Logout Summary report?
The maximum value is 12 months. This data retention period is configurable.

Agent Not Ready By Reason Code
Definition
Displays the reason code associated with the agent Not Ready (aux.) state.

How it works
Tracks the agent activity associated with the agent Not Ready (aux.) state. Supervisors can view
and analyze the reason codes that the agents assign to the Agent Not Ready state for a selected

Agent Login/Logout Summary
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interval. Intervals are aggregated by 15 minutes and can be Daily, Weekly, Monthly, or Yearly.
Data displayed is listed at agent level, and data is written to the database every 15 minutes.

Business usage
• How many agents are showing the same not ready reason codes and not ready reasons for

the selected interval?
Sort by the Not Ready Reason Code and Not Ready Reason measures to determine the
same codes used by the agents.

• Which are the top reason codes that agents use?
Use the Not Ready Reason Code measure to determine the most used reason codes by the
agents for the selected interval.

• Are agents utilizing the same reason codes multiple times?
Use the Agent ID, Agent User Handle, and Not Ready Reason Code measures to
determine whether agents are using the same codes multiple times in the selected interval.

• Which reason codes are used most by the agents, and what is the maximum duration of
these codes?
Sort by the Not Ready Reason Code measure to determine the codes that have maximum
usage and view the Total Duration measure to determine the duration that agents spent in
the Not Ready (aux.) state for the selected interval.

• Are agents exceeding the thresholds defined for each reason code for the selected interval?
Use the Agent ID, Agent User Handle, and Not Ready Reason Code measures to
determine the reason codes used by agents. Correlate these measures with the Total
Duration measure to determine whether agents are exceeding their threshold.

• Which codes are used most by the agents and which code has maximum occurrences for the
selected interval?
Sort by the Not Ready Reason Code measure to determine the codes that have maximum
usage. Correlate it with Occurrences to determine the maximum occurrences of the code.

Agent Performance

Agent Performance Summary
Definition
Displays the performance and productivity of an agent by Channels for the current interval.

How it works
Tracks how agents handle contacts delivered to them for the current interval. Supervisors can
view how the agents handle contacts delivered to them for a selected interval. Intervals are
aggregated by 15 minutes and can be either an Interval, Daily, Weekly, Monthly or Yearly. Data
displayed is listed at agent level and data is written to the database every 15 minutes.
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You can drill down on an agent to view the Agent Details report. This report provides agent
performance at a detail level.
You can drill down on Abandoned, Completed, Conferenced, Offered, Transferred, Not Answered,
Consulted, and Number of Holds measures to view the Agent Interaction Detail report. This
report provides agent interactions for the selected measure. All timestamps pertaining to this
report are displayed in UTC time format only.

Business usage
Monitor and compare the performance of each agent for the selected interval to view how the
agents use their time. This report provides answers to some key questions, such as:

• How many contacts were offered to an agent and how many of these contacts were
completed for the selected interval?
Use the Offered measure to determine the number of contacts directed towards the agent for
the selected interval. Use the Completed measure to determine the number of completed
contacts.

• How many contacts did an agent handle for the selected interval duration, and what is the
duration for which each contact was handled?
Use the Completed measure to determine the number of contacts handled by the agent.
Drill down on the agent and use the Active Time measure to determine the active duration
spent by the agent to handle the contacts.

• How many contacts did an agent put on hold for the selected interval?
Drill down on the agent and use the Hold Count measure to determine the number of
contacts put on hold by the agent for the selected interval.

• How many contacts did an agent transfer to other agents for the selected interval duration?
Drill down on the agent to Agent Details. Hover the mouse over the Transferred measure in
the Agent Performance Counts view to determine the number of contacts transferred by the
agent to other agents for the selected interval.

• How do you compare the active duration and idle duration of an agent for the selected time
interval?
Compare the Active Time measure with the Idle Time measure to determine the time spent
by an agent in idle state in relation to active state. You can also use the Average Active
Time measure to know the average active time spent by the agent.

• How do you compare the agent's performance for the current interval with other similar time
intervals?
Compare the number of contacts offered and the number of contacts completed and
answered with escalations with other similar time intervals to determine the agent’s
performance.

• Is there an improvement in the performance of the agent?
Compare the agent’s performance in the current interval with data derived from other
intervals to see if the performance of the agent is improving.

• How can you view the agent’s performance at a glance for the selected intervals?

Agent Performance
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See the field Grand Total for all the measures in the table, or hover your mouse over the
measures in Agent Performance Counters.

• How can you view the agent’s blended engagement performance?
Drill down to Agent Details report. See Agent Performance Blended Engagements View.

• How do you determine the reason for the segment type of a call?
Drill down to Agent Interaction Details report. Use the Segment Type measure to
determine the reason of the segment type of a call.

• How do you determine whether the supervisor has barged-out the agent from the call?
Drill down to Agent Interaction Details report. Use the Barged Out Indicator measure to
determine whether the supervisor has removed the agent from the call.

Agent Performance Top 5 and Bottom 5
Definition
Displays a performance summary of the top five and the bottom five agents for the current interval.
If more than five agents have the same values for metrics on which the agents are ranked, the
report displays all such agents.

How it works
Tracks the performance of the contact center agents on a daily basis for the current interval.
Intervals are aggregated by 15 minutes and can be either an Interval, Daily, Weekly, Monthly or
Yearly. Data displayed is listed at agent level and data is written to the database every 15 minutes.
The Top 5 report is a daily report that shows the performance summary of the five agents who
successfully completed the highest number of customer engagements.
The Bottom 5 report is a daily report that shows the performance summary of the five agents who
completed the lowest number of customer engagements.

Business usage
Compare the performance of the top five and bottom five agents for the current interval to
determine those agents who are using their active time productively and those who are not.
This report provides answers to some key questions, such as:

• How do the top five agents compare in answering the contacts for the current interval?
Use the Answered measure to determine the number of contacts answered by the top five
agents.

• How do the top five agents compare in using the answering time productively for the current
interval?
Use the Active Time Duration measure to determine and compare the time duration for
which the agents were actively answering the calls.

• How do the top five agents compare in completing the contacts directed to them and the
corresponding percentage of completion for the current interval?
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Use the Completed and % Complete measure to determine and compare the call
completion attribute of the agents.

• How many contacts did the top five agents not answer in the reporting period for the current
interval?
Use the Not Answered measure to determine and compare the contacts that were not
answered by the agents.

• How do the bottom five agents compare in not answering the contacts for the current
interval?
Use the Not Answered measure to determine the number of contacts not answered by the
bottom five agents.

Agent Compare
Definition
Displays a comparison of different agent measures.

How it works
Tracks performance of selected agents by comparing different agent measures in the current
interval. Supervisors can select a maximum of five agents for comparing on different measures.

Business usage
• How many contacts were offered to agents in the current interval, and how many of these

contacts were completed?
Use the Offered and Completed measures to compare the performance of the agents.

• How many contacts were offered to agents in the current interval, and how many of these
contacts were abandoned?
Use the Offered and Abandoned measures to compare the number of contacts abandoned
by the agents.

• How many contacts offered to the agents were transferred or conferenced since start of the
day?
Compare the Transferred and Conferenced measures with the Offered measures to know
the count of contacts that were either transferred or conferenced for the current interval.

Agent Behaviour
Definition
Displays individual occurrences of agent behaviors that are associated with engagement handling
activities.

How it works
Tracks how agents handle contacts delivered to them for the current interval. Supervisors can
view the agent behaviors for the contacts delivered to them for a selected interval. Intervals are
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aggregated by 15 minutes and can be an Interval, Daily, Weekly, Monthly, or Yearly. Data
displayed is listed at agent level and written to the database every 15 minutes.
This report includes counts for the following types of behaviors:

• Duration-based behaviors such as Short Not Ready (aux.) and % Long Holds. Counts for
duration-based behaviors require an administered behavior definition that specifies a time
duration.

• Event-based behaviors such as Transferred, Consults, and Answered that are counted
automatically.

Business usage
• What percentage of calls are transferred or escalated (consults) by the agent for the selected

interval?
Use the % Transferred or % Consults measure to identify the calls that were transferred or
escalated by the agent.

• What percentage of calls are kept on hold by the agent for longer durations for the selected
interval?
Use the % Long Holds measure to identify the agents who keep the calls on hold for
durations longer than the company objectives.

• How do you identify the long engagements that exceed thresholds for the selected interval?
Use the % Long Engagements measure to identify the agents who exceeded the company
objectives.

• How do you identify the agent behaviors that meet or exceed the company objectives?
View the counts of different measures to identify the agent's behavior.

Contact Center Performance Summary
Definition
Displays the performance summary of a contact center site.

How it works
Tracks behaviour aspects and contact activities of a contact center site for the selected interval.
Intervals are aggregated by 15 minutes and can be either an Interval, Daily, Weekly, Monthly or
Yearly. Supervisors can select the interval for reporting and track historical performance of the
contact center.
This report contains the following summaries:

• Behaviour Summary: Provides information about the various types of agent behaviors that
can have a significant impact on cost of service or customer satisfaction.

• Contact Summary: Provides information about the status of all contacts that dialed in to the
contact center.
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Note:
Avaya Analytics™ supports one site only.

Business usage
• How many contacts were offered to the given site for the selected interval and how many of

them were transferred to an agent or a service?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Trans Initiate to Agent and Trans Initiate to Service measures to determine the
number of contacts that were transferred to an agent or a service.

• What does the high number of counts in the Behaviour Summary pie-chart indicate?
Behaviour counts can be attributed to agent behaviour in a contact center and can be
analyzed to determine whether agents need more training or if the efficiency of agents have
reduced. It can also be used to analyze whether agents are performing certain actions that
are greater than set goals of a contact center.

• How many contacts were offered to the given site for the selected interval and how many of
them abandoned while in a queue and how many of them abandoned while alerting?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Abandoned From Queue and Abandoned from Alerting measures to determine
the number of contacts that abandoned from queue or abandoned from alerting.

• How many contacts were offered to the given site for the selected interval and what
percentage of them abandoned while in a queue and what percentage of them abandoned
while alerting?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the % Abandoned From Queue and % Abandoned from Alerting measures to
determine the percentage of contacts that abandoned from queue or abandoned from
alerting.

• How many contacts were offered to the given site for the selected interval and how many of
them were answered and how many of them were not answered?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Answered and Not Answered measures to determine the number of calls answered
and number of calls unanswered.

• How many contacts were offered to the given site for the selected interval and how many of
them were deferred by the agent?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the % Answered and % Not Answered measures to determine the percentage of calls
answered or unanswered.

• How many contacts were offered to the given site for the selected interval and how many of
them were deferred by the agent?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Deferred Contacts measure to determine the contacts that the agent answered and
subsequently deferred.

Contact Center Performance Summary
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Engagement
Definition
Displays data related to customer engagements across various parameters.

How it works
Tracks historic details of all engagements. Supervisors can use these reports to determine the
movement of customer engagements in a contact center. The start time of engagements
determine the data displayed in the report.
Supervisors can track engagement details of routing services within the routing service group.
Supervisors can only view routing services and routing service measures associated with the
routing service group to which the supervisor is assigned.
You can drill down on Engagement ID to get finer details of each engagement. You can drill down
on Contact ID to analyze how the engagement was handled at each segment level. An
engagement is associated with a contact ID where as a segment is associated with an agent.

Business usage
• How do you determine the movement of a customer engagement in a contact center?

Use Engagement Summary Report to understand the number of engagements that were
listed in the current interval.
Navigate to Engagement Detail Report to understand the details of the engagement.
Navigate to Contact Detail Report to understand the details of segments, and segment
durations of an engagement.

• How do you determine the usage of a channel across the contact center?
In the Input prompt, select TimeZone, specify the values for the Interval and select the
Channel for analysis. The report displays engagement details associated with the selected
channel.
Use the Engagement Distribution By Channel graph to determine the usage of channels
across the contact center.

• How do you determine the duration of an engagement in a particular channel?
In Engagement Summary Report, click an Engagement ID to display the Engagement
Contact Report. Use the Start Time and End Time measures to determine the duration of
the engagement in a particular channel.

• How do you determine the average engagement duration in the current interval?
Use the Average Engagement Duration measure.

• For a given contact, how do you determine the duration the segment spent in agent
activities?
Use the Segment Detail Report along with Segment Durations graph to determine the
duration spent for agent activities.

Historical reports summary overview
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Contact Detail Summary
Definition
Displays the end-to-end details of a call.

How it works
Tracks historical details of a call including the agent who handled the call, the calling party, the
handling time, and the alert time. The report also displays the routing service involved in the call.
Supervisors can select the Contact ID in the Engagement Summary report to analyze how the
agent handled the engagement at a segment level. An engagement is associated with contacts
whereas a segment is associated with an agent.

Business usage
• How do you determine whether a caller was in a queue before getting connected to an

agent?
Use the Wait Time Indicator measure. If the value is True, then the contact was in a queue
waiting to be connected to an agent.

• How do you determine if a contact was deferred?
Use the Deferred Indicator measure. If the value is True, then the contact was deferred.

• How do you determine the duration an agent spends in a channel for a given segment?
Use the Engagement ID, Contact ID, and Agent ID measures to determine the segment.
Use the Channel, Start Time, and End Time to know the duration an agent spends in a
channel.

• For a given contact, how do you determine the duration of the segment spent in agent
activities?
Use the Segment Detail Report with the Segment Durations graph to determine the duration
spent on agent activities.

• How do you determine if an agent replied to a customer email?
Use the Reply Indicator in the Contact Detail report. If the value is True, then the agent has
replied to an email. The default value is False.

• What is the maximum data retention period of the Call Detail Records (CDR) data?
The maximum retention period is 365 days. This data retention period is configurable.

Messaging Engagement Summary
Definition
Displays the data related to customer engagements originated on the Messaging channel across
various parameters.

How it works
The report is similar to Engagement report. It tracks historical details of engagement originated on
the Messaging channel. Supervisors can select the conversation and analyze how it traverses

Contact Detail Summary
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through multiple engagements. The start time of engagement determines the data displayed in the
report.
You can drill down on Engagement ID to get finer details of each engagement. You can drill down
on Contact ID to analyze how the engagement was handled at each segment level. Conversation
ID is associated with a contact ID and an engagement is associated with a contact ID where as a
segment is associated with an agent.

Business usage
• How do you determine the movement of a conversation thread in a contact center?

Use Messaging Engagement Summary Report to understand the number of conversation
threads that were listed in the current interval at Messaging channels.
Navigate to Conversation Detail Report to understand the lifecycle details of the
conversation thread, count of engagements of the conversation thread, total active time, and
the list of engagements originated for it. Navigate to Engagement Detail Report to
understand the details of the particular engagement of the conversation thread. Navigate to
Contact Detail Report to understand the details of segments, and segment durations of an
engagement.

• How do you determine contact center’s services on which Messaging conversation threads
are routed most frequently at some particular period?
In the Input prompt, select TimeZone and specify the values for the Interval. The report
displays conversation threads’ details for the selected time interval.
Use the Top 5 Routing Services by Usage graph to determine the usage of routing services
across the contact center for a particular time interval.

• How do you determine usage of applications at Messaging channels at contact center?
Use Engagement distribution per Application graph to identify usage of applications for
messaging conversation threads at the particular time interval.

• How do you determine the duration of an engagement of a particular conversation thread?
In Messaging Engagement Summary Report, click an Engagement ID to display
Engagement Contact Report. Use the Start Time and End Time measures to determine
the duration of the engagement in a particular channel.

• How do you determine the average engagement duration in the current interval?
Use the Average Engagement Duration measure.

Routing Service Summary
Definition
Displays overall performance of a routing service for the selected interval.

How it works
Tracks the performance of the routing service for the current interval. Intervals are aggregated by
15 minutes and can be 15 Minutes, Hourly, Daily, Weekly, and Monthly.

Historical reports summary overview
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Supervisors can select the routing services within a routing service group for reporting and track
the channels' historical performance. Supervisors can only view routing services and routing
service measures associated with the routing service group to which they are assigned.
This report displays routing services, their attributes, and channels through which a contact is
routed and provides a snapshot of metric through a Pie chart View.

Business usage
Monitor and compare the performance of each Routing Service for the selected interval.
This report provides answers to some key questions, such as:

• How many contacts has a routing service offered, and how many agents were serviced by
the routing service for the selected interval?
Use the Offered measure to determine the number of contacts offered through the routing
service. Use the Agent Count measure to determine the agents serviced by the routing
service.

• How do you compare the usage of routing services by channels?
Use the Channel measure to determine the usage of multichannel serviced by routing
service.

• How do you determine the performance of a routing service for the selected interval?
Use the % Service Level measure to determine the percentage of engagements with the
routing service. Use the % Occupancy measure to determine the time spent by an agent in
engagement service work for the routing service.

• How do you view the abandoned contacts across routing services?
Click Routing Service Summary - Contacts tab. Input values on the page and click Apply.
Hover the mouse over each pie in the Pie chart View.

• How do you know that the performance of the routing service is improving?
Compare the routing service performance in the current interval with data derived from other
intervals.

Supervisor

Supervisor Activity
Definition
Displays a summary of the supervisor’s activity for the current reporting interval.

How it works
Tracks the number of agents observed, barged out of contacts, and coached by the supervisor.
Administrators can view the number of times that the supervisor observed the agents and
provided coaching. For each supervisor, the report displays a Grand Total and a Sub Total.

Supervisor
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From the Inputs prompt, you can filter reports by one or more supervisors.

Business usage
• How do you determine the number of agents that the supervisor was observing?

Use the Observing measure to know the number of contacts where the supervisor was
observing the agent.

• How do you know the number of agents that the supervisor was observing and provided
coaching?
Use the Observing measure to know the number of contacts for which the supervisor was
observing the agent. Use the Coaching measure to know the number of contacts for which
the supervisor provided coaching to the agent.

• How do you determine the number of agents a particular supervisor was observing, provided
coaching to, or barging in on?
Filter the report by Supervisor Name. Use the Observing, Coaching, and Barged In
measures to determine the number of agents where the supervisor was observing, coaching,
or barging in.

You can drill down on the Observing, Coaching, and Barged-In measures.

Supervised Agent Activity
Definition
Displays details of supervised agents and their behavior aspects in the current reporting interval.

How it works
Tracks how many agents were observed, barged out of contacts, and coached by the supervisor.
Supervisors can view how the agents handle contacts delivered to them for a selected interval.
This includes contacts that the agents transferred to other agents or service.
You can filter the report by:

• Agents: Displays details of the selected agents grouped by their reporting supervisor.
• Supervisor: Displays details for all agents reporting to each supervisor.
• Agent Group: Displays details for all agents in the group based on their reporting supervisor.

You can drill down on the Coached, Observed, and Barged Out measures.

Business usage
• How do you determine the number of contacts answered by the agent?

Use the Answered measure to know the number of contacts answered by an agent.
• How do you determine the number of contacts that the supervisor observed or barged out the

agent from the contacts?
Use the Observed and Barged Out measures to know the number of contacts where the
agent was observed or barged out of the contact.

• How do you know the number of contacts for which the agent was observed and coached?

Historical reports summary overview
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Use the Observed measure to know the number of contacts for which the agent was
observed. Use the Coached measure to know the number of contacts for which the agent
was coached.

• How many contacts did the agent transfer to an agent or a service?
Use the Transferred to Agent and Transferred to Service measures to know the contacts
transferred to another agent or service.

Supervised Agent Compare
Definition
Displays a comparison of supervised agents for the current reporting interval.

How it works
Tracks activities of supervised agents by comparing agents on different measures in the current
interval. Supervisors can select maximum five agents for this activity.
You can filter agents of your interest to see the comparison.
Filter the report by Agent Groups to limit the agents comparison in a group.

Business usage
• How do you compare the supervised agents that were observed and coached?

Use the Observed and Coached measures to compare the activities of the supervised
agents.

• How do you compare the supervised agents that were observed and removed from the call?
Use the Observed and Barged Out measures to compare the activity of the supervised
agents that were removed from the call.

• How many times did the supervisor intervene in the calls for the current interval?
Use the Barged In measure to know the number of times the supervisor intervene in the
calls.

Time Series
Definition
Displays the engagement of agents in a individual routing service for the current interval.

How it works
Tracks the overall trends in performance of agents and agent engagements associated with a
routing service in a Routing Service Group against a set service level for the current interval.
Supervisors can select the routing services within a routing service group for reporting and track
the channels' historical performance. Supervisors can only view routing services and routing
service measures associated with the routing service group to which they are assigned.

Time Series
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Business usage
• How do you determine the usage of each channel for different measures in the current

interval?
View the Engagements trend graph and use different measures from the drop-down list to
know the usage of each channel.

• How do you determine if the channel is approaching the defined service level for the current
interval?
View the % Service Level trend graph to know the percentage usage of each channel.

• How do you compare the usage of different channels for the current interval?
View the % Service Level trend graph to know the percentage usage of each channel.
Analyze the usage pattern of each channel.

• How do you determine what is happening at the routing point for the current interval?
Use the % Service Level measure to understand the maximum service level reached. View
the Calls Abandoned After Threshold measure to analyze the number of calls abandoned
after the routing service reached its set threshold limit.

• How do you determine if the routing service is used to its fullest for the current interval?
View the % Service Level measure to determine the calls offered through the routing service
against the set service level.

VDN Summary
Definition
Displays overall performance of a routing point with respect to the customer experience.
This report supports route point reporting for calls that terminate in treatment VDNs or for callers
who leave a message. Where Avaya Oceana® is non-operational, pre-existing agents are directed
to fallback to Elite.

How it works
Tracks the performance of the routing point for the selected interval. Intervals are aggregated
every 15 minutes and can be either a specific Interval or Daily, Weekly, and Monthly. Supervisors
can select the routing points and routing point sub-type for reporting and track historical
performance of the routing points.
Supervisors can use this report to compare routing points with respect to compliance with service
level goals or to compare routing points with other measures.
This report supports the following routing points:

Historical reports summary overview
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Route Point Type SubType Channels (Oceana®)
VDN INGRESS, RONA,

XFER2SERVICE, FALLBACK,
COVERAGE, and TREATMENT

PSTN VOICE

RoutePoint ROUTING, and XFER2SERVICE OCP Channels

Business usage
• How many contacts were handled by the selected routing point and routing point sub-type for

the selected interval, and how many of them were disconnected?
Use the Handled measure to determine the number of contacts handled by the selected
routing point and routing point subtype. Use the Disconnects measure to determine the
number of contacts that were disconnected.

• How many contacts were handled by the selected routing point and routing pointy sub-type
for the selected interval and how much time was required for routing?
Use the Handled measure to determine the number of contacts handled by the selected
routing point and routing point subtype. Use the Routing Duration measure to determine the
routing duration of these contacts.

• How do you determine the performance of a routing point in the selected interval?
Use the Handled measure to determine the number of contacts handled by the routing point.
Use the Routing Duration measure along with other measures, such as Disconnects and
Average Wait Time, to determine the performance of the routing point.

• How do you know that the performance of a routing point is improving?
Compare the routing point performance in the current interval with data derived from other
intervals.

VDN Summary
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Chapter 7: Historical reports daily summary
overview

Using historical reports daily, you can generate reports for a week, month, or year based on with
daily roll-up data. These report do not include data for the current day, because the data is
calculated only the next day. The data retention period for these reports is configurable. The
maximum data retention period for these reports is 60 months.

The historical reports based on daily roll-ups available in Avaya Analytics™ are:

• Account By Agent Daily
• Agent By Routing Service Daily
• Agent Not Ready by Reason Code Daily
• Agent Performance Summary Daily
• Contact Center Daily
• Routing Service Daily
• Supervisor Activity Daily
• Time Series Daily
• VDN Summary Daily

For more detailed information about the measures, data, and reports that Avaya Analytics™

provides, see Avaya Analytics™ Data Dictionary available from the Avaya Support website at https://
support.avaya.com.

This chapter provides a summary of the historical reports that are based on daily roll-up data, such
as how each reports work and the respective business usage.

Account by Agent Daily Summary
Definition
Displays a summary of agents who handled the contacts for the accounts during the selected
duration.

How it works
Tracks the performance of the contact center agents by account for the selected duration. The
duration is rolled-up daily and can be either Daily, Weekly, Monthly or Yearly. Supervisors can
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select the agents to report on and analyze the performance of agents serving the accounts for the
selected duration.
This report displays the accounts, their attributes, and the channels through which a contact is
routed.

Business usage
• How many contacts were offered to the agent and for which accounts for the selected

duration?
Use the Offered measure to determine the number of contacts offered to the agent. Use the
Account ID measure to determine the accounts serviced by the agent.

• How many accounts did the agent service for the selected duration?
Use the Account ID measure to determine the accounts that the agent serviced.

• How do you determine the usage of channels by agent for the reporting period?
Use the Channel measure to determine the number of channels that the agent supported
while supporting an account. Use the Active Time measure to determine the active time
spent by the agent for the selected channel.

• How do you determine the occupancy rate of the agent for each account for the selected
duration?
Use the Account ID measure to determine the accounts that the agent supported the most.
Use the Average Active Time measure to determine the active time spent by the agent for
the accounts.

Agent By Routing Service Daily
Definition
Displays how agents use routing services for the selected duration.

How it works
Tracks the performance of agents by channels associated with a routing service for the selected
duration. The duration is aggregated daily and can be Daily, Weekly, Monthly, and Yearly.
Supervisors can select the routing services within a routing service group for reporting and track
the channels' historical performance. Supervisors can only view routing services and routing
service measures associated with the routing service group to which they are assigned.

Business usage
• How do you determine an agent performance by routing service for the selected duration?

You can determine an agent's performance by analyzing the data in the agent's Offered,
Abandoned, Answered, Transferred, and Consults measures.

• How do you determine the usage of channels by an agent for the selected duration?
You can create a report by selecting the required routing service and corresponding
channels. In the report, you can select the channels and determine the usage of each
channel by the agent.

Agent By Routing Service Daily
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• How do you compare the performance of agents by routing services for the selected
duration?
Use the Offered and Answered measures to determine the number of engagements
directed and answered. Use the Number of Holds measure to determine the number of
times that the engagements were put on hold by the agent.

• How do you determine the usage of routing services for the selected duration?
Generate reports using different intervals. Analyze the usage pattern of routing services and
associated channels for different intervals to gain an insight on the usage pattern of the
routing services.

Agent Not Ready By Reason Code Daily
Definition
Displays the reason code associated with the agent Not Ready auxiliary state.

How it works
Tracks the agent activity associated with the agent Not Ready auxiliary state. Supervisors can
view and analyze the reason codes that the agents assign to the Agent Not Ready state for a
selected duration. The duration is aggregated daily and can be Daily, Weekly, Monthly, or Yearly.
Data displayed is listed at agent level, and data is written to the database on the next day.

Business usage
• How many agents are showing the same not ready reason codes and not ready reasons for

the selected duration?
Sort by the Not Ready Reason Code and Not Ready Reason measures to determine the
same codes used by the agents.

• Which are the top reason codes that agents use?
Use the Not Ready Reason Code measure to determine the most used reason codes by the
agents for the selected duration.

• Are agents utilizing the same reason codes multiple times?
Use the Agent ID, Agent User Handle, and Not Ready Reason Code measures to
determine whether agents are using the same codes multiple times in the selected duration.

• Which reason codes are used most by the agents, and what is the maximum duration of
these codes?
Sort by the Not Ready Reason Code measure to determine the codes that have maximum
usage and view the Total Duration measure to determine the duration that agents spent in
the Not Ready auxiliary state for the selected duration.

• Are agents exceeding the thresholds defined for each reason code for the selected duration?
Use the Agent ID, Agent User Handle, and Not Ready Reason Code measures to
determine the reason codes used by agents. Correlate these measures with the Total
Duration measure to determine whether agents are exceeding their threshold.

Historical reports daily summary overview
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• Which codes are used most by the agents and which code has maximum occurrences for the
selected duration?
Sort by the Not Ready Reason Code measure to determine the codes that have maximum
usage. Correlate it with Occurrences to determine the maximum occurrences of the code.

Agent Performance

Agent Performance Summary Daily
Definition
Displays the performance and productivity of an agent by Channels for the selected duration.

How it works
Tracks how agents handle contacts delivered to them for the selected duration. Supervisors can
view how the agents handle contacts delivered to them for a selected duration. The duration is
aggregated daily and can be either, Daily, Weekly, Monthly or Yearly. Data displayed is listed at
agent level and data is written to the database the next day.

Business usage
Monitor and compare the performance of each agent for the selected duration to view how the
agents use their time. This report provides answers to some key questions, such as:

• How many contacts were offered to an agent and how many of these contacts were
completed for the selected duration.
Use the Offered measure to determine the number of contacts directed towards the agent for
the selected interval. Use the Completed measure to determine the number of completed
contacts.

• How many contacts did an agent handle for the selected duration, and what is the duration
for which each contact was handled?
Use the Completed measure to determine the number of contacts handled by the agent.

• How do you compare the active duration and idle duration of an agent for the selected
duration?
Compare the Active Time measure with the Idle Time measure to determine the time spent
by an agent in idle state in relation to active state. You can also use the Average Active
Time measure to know the average active time spent by the agent.

• How do you compare the agent's performance for the current daily report with other similar
daily reports?
Compare the number of contacts offered and the number of contacts completed and
answered with escalations with other similar durations to determine the agent performance.

• Is there an improvement in the performance of the agent?

Agent Performance
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Compare the agent performance in the selected duration with data derived from other
durations to see if the performance of the agent is improving.

• How can you view the agent’s performance at a glance for the selected duration?
See the field Grand Total for all the measures in the table, or hover your mouse over the
measures in Agent Performance Counters.

Agent Performance Top 5 and Bottom 5 Daily
Definition
Displays a performance summary of the top five and the bottom five agents for the selected
duration.
If more than five agents have the same values for metrics on which the agents are ranked, the
report displays all such agents.

How it works
Tracks the performance of the contact center agents on a daily basis for the selected duration.
The duration is aggregated daily and can be either, Daily, Weekly, Monthly or Yearly. Data
displayed is listed at agent level and data is written to the database the next day.
The Top 5 report is a daily report that shows the performance summary of the five agents who
successfully completed the highest number of customer engagements.
The Bottom 5 report is a daily report that shows the performance summary of the five agents who
completed the lowest number of customer engagements.

Business usage
Compare the performance of the top five and bottom five agents for the selected duration to
determine those agents who are using their active time productively and those who are not.
This report provides answers to some key questions, such as:

• How do the top five agents compare in answering the contacts for the selected duration?
Use the Answered measure to determine the number of contacts answered by the top five
agents.

• How do the top five agents compare in using the answering time productively for the selected
duration?
Use the Active Time Duration measure to determine and compare the time duration for
which the agents were actively answering the calls.

• How do the top five agents compare in completing the contacts directed to them and the
corresponding percentage of completion for the selected duration?
Use the Completed and % Complete measure to determine and compare the call
completion attribute of the agents.

• How many contacts did the top five agents not answer in the reporting period for the selected
duration?
Use the Not Answered measure to determine and compare the contacts that were not
answered by the agents.
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• How do the bottom five agents compare in not answering the contacts for the selected
duration?
Use the Not Answered measure to determine the number of contacts not answered by the
bottom five agents.

Agent Compare Daily
Definition
Displays a comparison of different agent measures.

How it works
Tracks performance of selected agents by comparing different agent measures in the selected
duration. Supervisors can select a maximum of five agents for comparing on different measures.

Business usage
• How many contacts were offered to agents in the selected duration, and how many of these

contacts were completed?
Use the Offered and Completed measures to compare the performance of the agents.

• How many contacts were offered to agents in the selected duration, and how many of these
contacts were abandoned?
Use the Offered and Abandoned measures to compare the number of contacts abandoned
by the agents.

• How many contacts offered to the agents were transferred or conferenced since start of the
day?
Compare the Transferred and Conferenced measures with the Offered measures to know
the count of contacts that were either transferred or conferenced for the selected duration.

Agent Behavior Daily
Definition
Displays individual occurrences of agent behaviors that are associated with engagement handling
activities.

How it works
Tracks how agents handle contacts delivered to them for the selected duration. Supervisors can
view the agent behaviors for the contacts delivered to them for a selected duration. The duration is
aggregated daily and can be Daily, Weekly, Monthly, or Yearly. Data displayed is listed at agent
level and written to the database the next day.
This report includes counts for the following types of behaviors:

• Duration-based behaviors such as Short Not Ready (aux.) and % Long Holds. Counts for
duration-based behaviors require an administered behavior definition that specifies a time
duration.

Agent Performance
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• Event-based behaviors such as Transferred, Consults, and Answered that are counted
automatically.

Business usage
• What percentage of calls are transferred or escalated (consults) by the agent for the selected

duration?
Use the % Transferred or % Consults measure to identify the calls that were transferred or
escalated by the agent.

• What percentage of calls are kept on hold by the agent for longer durations for the selected
duration?
Use the % Long Holds measure to identify the agents who keep the calls on hold for
durations longer than the company objectives.

• How do you identify the long engagements that exceed thresholds for the selected duration?
Use the % Long Engagements measure to identify the agents who exceeded the company
objectives.

• How do you identify the agent behaviors that meet or exceed the company objectives?
View the counts of different measures to identify the agent's behavior.

Contact Center Performance Summary Daily
Definition
Displays the performance summary of a contact center site daily.

How it works
Tracks behavior aspects and contact activities of a contact center site for the selected duration.
The duration is aggregated daily and can be either Daily, Weekly, Monthly or Yearly. Supervisors
can select the duration for reporting and track historical performance of the contact center.
This report contains the following summaries:

• Behaviour Summary: Provides information about the various types of agent behaviors that
can have a significant impact on cost of service or customer satisfaction.

• Contact Summary: Provides information about the status of all contacts that dialed in to the
contact center.

Note:
Avaya Analytics™ supports one site only.

Business Usage
• How many contacts were offered to the given site for the selected duration and how many of

them were transferred to an agent or a service?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Trans Initiate to Agent and Trans Initiate to Service measures to determine the
number of contacts that were transferred to an agent or a service.

Historical reports daily summary overview
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• What does the high number of counts in the Behaviour Summary pie-chart indicate?
Behaviour counts can be attributed to agent behaviour in a contact center and can be
analyzed to determine whether agents need more training or if the efficiency of agents have
reduced. It can also be used to analyze whether agents are performing certain actions that
are greater than set goals of a contact center.

• How many contacts were offered to the given site for the selected duration and how many of
them abandoned while in a queue and how many of them abandoned while alerting?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Abandoned From Queue and Abandoned from Alerting measures to determine
the number of contacts that abandoned from queue or abandoned from alerting.

• How many contacts were offered to the given site for the selected duration and what
percentage of them abandoned while in a queue and what percentage of them abandoned
while alerting?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the % Abandoned From Queue and % Abandoned from Alerting measures to
determine the percentage of contacts that abandoned from queue or abandoned from
alerting.

• How many contacts were offered to the given site for the selected duration and how many of
them were answered and how many of them were not answered?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Answered and Not Answered measures to determine the number of calls answered
and number of calls unanswered.

• How many contacts were offered to the given site for the selected duration and how many of
them were deferred by the agent?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the % Answered and % Not Answered measures to determine the percentage of calls
answered or unanswered.

• How many contacts were offered to the given site for the selected duration and how many of
them were deferred by the agent?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Deferred Contacts measure to determine the contacts that the agent answered and
subsequently deferred.

Routing Service Summary Daily
Definition
Displays overall performance of a routing service for the selected duration.

How it works
Tracks the performance of the routing service for the selected duration. The duration is
aggregated daily and can be Daily, Weekly, and Monthly.

Routing Service Summary Daily
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Supervisors can select the routing services within a routing service group for reporting and track
the channels' historical performance. Supervisors can only view routing services and routing
service measures associated with the routing service group to which they are assigned.
This report displays routing services, their attributes, and channels through which a contact is
routed and provides a snapshot of metric through a Pie chart View.

Business usage
Monitor and compare the performance of each Routing Service for the selected duration.
This report provides answers to some key questions, such as:

• How many contacts has a routing service offered, and how many agents were serviced by
the routing service for the selected duration?
Use the Offered measure to determine the number of contacts offered through the routing
service. Use the Agent Count measure to determine the agents serviced by the routing
service.

• How do you compare the usage of routing services by channels?
Use the Channel measure to determine the usage of multichannel serviced by routing
service.

• How do you determine the performance of a routing service for a selected duration?
Use the % Service Level measure to determine the percentage of engagements with the
routing service. Use the % Occupancy measure to determine the time spent by an agent in
engagement service work for the routing service.

• How do you view the abandoned contacts across routing services?
Click Routing Service Summary - Contacts tab. Input values on the page and click Apply.
Hover the mouse over each pie in the Pie chart View.

• How do you know that the performance of the routing service is improving?
Compare the routing service performance in the selected duration with data derived from
other durations.

Supervisor Daily

Supervisor Activity Daily
Definition
Displays a summary of the supervisor’s activity for the selected reporting duration.

How it works
Tracks the performance of the routing service for the selected duration. The duration is
aggregated daily and can be Daily, Weekly, and Monthly.

Historical reports daily summary overview
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Business usage
• How do you determine the number of agents that the supervisor was observing?

Use the Observing measure to know the number of contacts where the supervisor was
observing the agent.

• How do you know the number of agents that the supervisor was observing and provided
coaching?
Use the Observing measure to know the number of contacts for which the supervisor was
observing the agent. Use the Coaching measure to know the number of contacts for which
the supervisor provided coaching to the agent.

• How do you determine the number of agents a particular supervisor was observing, provided
coaching to, or barging in on?
Filter the report by Supervisor Name. Use the Observing, Coaching, and Barged In
measures to determine the number of agents where the supervisor was observing, coaching,
or barging in.

Supervised Agent Activity Daily
Definition
Displays details of supervised agents and their behavior aspects in the selected reporting
duration.

How it works
Tracks how many agents were observed, barged out of contacts, and coached by the supervisor.
Supervisors can view how the agents handle contacts delivered to them for a selected duration.
This includes contacts that the agents transferred to other agents or service.
You can filter the report by:

• Agents: Displays details of the selected agents grouped by their reporting supervisor.
• Supervisor: Displays details for all agents reporting to each supervisor.
• Agent Group: Displays details for all agents in the group based on their reporting supervisor.

Business usage
• How do you determine the number of contacts answered by the agent?

Use the Answered measure to know the number of contacts answered by an agent.
• How do you determine the number of contacts that the supervisor observed or barged out the

agent from the contacts?
Use the Observed and Barged Out measures to know the number of contacts where the
agent was observed or barged out of the contact.

• How do you know the number of contacts for which the agent was observed and coached?
Use the Observed measure to know the number of contacts for which the agent was
observed. Use the Coached measure to know the number of contacts for which the agent
was coached.

Supervisor Daily
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• How many contacts did the agent transfer to an agent or a service?
Use the Transferred to Agent and Transferred to Service measures to know the contacts
transferred to another agent or service.

Supervised Agent Compare Daily
Definition
Displays a comparison of supervised agents for the current reporting interval.

How it works
Tracks activities of supervised agents by comparing agents on different measures in the current
interval. Supervisors can select maximum five agents for this activity.
You can filter agents of your interest to see the comparison.
Filter the report by Agent Groups to limit the agents comparison in a group.

Business usage
• How do you compare the supervised agents that were observed and coached?

Use the Observed and Coached measures to compare the activities of the supervised
agents.

• How do you compare the supervised agents that were observed and removed from the call?
Use the Observed and Barged Out measures to compare the activity of the supervised
agents that were removed from the call.

• How many times did the supervisor intervene in the calls for the scheduled duration?
Use the Barged In measure to know the number of times the supervisor intervene in the
calls.

Time Series Daily
Definition
Displays the engagement of agents with a routing service in a Routing Service Group for the
selected duration.

How it works
Tracks the overall trends in performance of agents and agent engagements associated with a
routing service against a set service level for the selected duration.
Supervisors can select the routing services within a routing service group for reporting and track
the channels' historical performance. Supervisors can only view routing services and routing
service measures associated with the routing service group to which they are assigned.

Historical reports daily summary overview
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Business usage
• How do you determine the usage of each channel for different measures in the selected

duration?
View the Engagements trend graph and use different measures from the drop-down list to
know the usage of each channel.

• How do you determine if the channel is approaching the defined service level for the selected
duration?
View the % Service Level trend graph to know the percentage usage of each channel.

• How do you compare the usage of different channels for the selected duration?
View the % Service Level trend graph to know the percentage usage of each channel.
Analyze the usage pattern of each channel.

• How do you determine what is happening at the routing point for the selected duration?
Use the % Service Level measure to understand the maximum service level reached. View
the Calls Abandoned After Threshold measure to analyze the number of calls abandoned
after the routing service reached its set threshold limit.

• How do you determine if the routing service is used to its fullest for the selected duration?
View the % Service Level measure to determine the calls offered through the routing service
against the set service level.

VDN Summary Daily
Definition
Displays overall performance of a routing point with respect to the customer experience.
This report supports route point reporting for calls that terminate in treatment VDNs or for callers
who leave a message. Where Avaya Oceana® is non-operational, pre-existing agents are directed
to fallback to Elite.

How it works
Tracks the performance of the routing point for the selected duration. The duration is aggregated
daily and can be either a Daily, Weekly, and Monthly. Supervisors can select the routing points and
routing point sub-type for reporting and track historical performance of the routing points.
Supervisors can use this report to compare routing points with respect to compliance with service
level goals or to compare routing points with other measures.
This report supports the following routing points:

Route Point Type SubType Channels (Oceana®)
VDN INGRESS, RONA,

XFER2SERVICE, FALLBACK,
COVERAGE, and TREATMENT

PSTN VOICE

RoutePoint ROUTING, and XFER2SERVICE OCP Channels

VDN Summary Daily
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Business usage
• How many contacts were handled by the selected routing point and routing point sub-type for

the selected duration, and how many of them were disconnected?
Use the Handled measure to determine the number of contacts handled by the selected
routing point and routing point subtype. Use the Disconnects measure to determine the
number of contacts that were disconnected.

• How many contacts were handled by the selected routing point and routing pointy sub-type
for the selected duration and how much time was required for routing?
Use the Handled measure to determine the number of contacts handled by the selected
routing point and routing point subtype. Use the Routing Duration measure to determine the
routing duration of these contacts.

• How do you determine the performance of a routing point?
Use the Handled measure to determine the number of contacts handled by the routing point.
Use the Routing Duration measure along with other measures, such as Disconnects and
Average Wait Time, to determine the performance of the routing point.

• How do you know that the performance of a routing point is improving?
Compare the routing point performance in the current duration with data derived from other
duration.

Historical reports daily summary overview
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Chapter 8: Historical reports monthly
summary overview

Using historical reports monthly, you can generate reports for a month or year based on the monthly
roll-up data. These reports do not include current month data, because the data is calculated the
next month. The data retention period for these reports is configurable. The maximum data retention
period for these reports is 9999 months.

The historical reports based on monthly roll-ups available in Avaya Analytics™ are:

• Account By Agent Monthly
• Agent By Routing Service Monthly
• Agent Not Ready by Reason Code Monthly
• Agent Performance Summary Monthly
• Contact Center Monthly
• Routing Service Monthly
• Supervisor Activity Monthly
• Time Series Monthly
• VDN Monthly

For more detailed information about the measures, data, and reports that Avaya Analytics™

provides, see Avaya Analytics™ Data Dictionary available from the Avaya Support website at https://
support.avaya.com.

This chapter provides a summary of the historical reports that are based on monthly roll-up data,
such as how each report works and their respective business usage.

Account by Agent Monthly Summary
Definition
Displays a summary of agents who handled the contacts for the accounts during the selected
duration.

How it works
Tracks the performance of the contact center agents by account for the selected duration. The
duration is rolled-up monthly and can be either Monthly or Yearly. Supervisors can select the
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agents to report on and analyze the performance of agents serving the accounts for the selected
duration.
This report displays the accounts, their attributes, and the channels through which a contact is
routed.

Business usage
• How many contacts were offered to the agent and for which accounts for the selected

duration?
Use the Offered measure to determine the number of contacts offered to the agent. Use the
Account ID measure to determine the accounts serviced by the agent.

• How many accounts did the agent service for the selected duration?
Use the Account ID measure to determine the accounts that the agent serviced.

• How do you determine the usage of channels by agent for the reporting period?
Use the Channel measure to determine the number of channels that the agent supported
while supporting an account. Use the Active Time measure to determine the active time
spent by the agent for the selected channel.

• How do you determine the occupancy rate of the agent for each account for the selected
duration?
Use the Account ID measure to determine the accounts that the agent supported the most.
Use the Average Active Time measure to determine the active time spent by the agent for
the accounts.

Agent By Routing Service Monthly
Definition
Displays how agents use routing services for the selected duration.

How it works
Tracks the performance of agents by channels associated with a routing service for the selected
duration. The duration is aggregated monthly and can be Monthly and Yearly.
Supervisors can select the routing services within a routing service group for reporting and track
the channels' historical performance. Supervisors can only view routing services and routing
service measures associated with the routing service group to which they are assigned.

Business usage
• How do you determine an agent performance by routing service for the selected duration?

You can determine an agent's performance by analyzing the data in the agent's Offered,
Abandoned, Answered, Transferred, and Consults measures.

• How do you determine the usage of channels by an agent for the selected duration?
You can create a report by selecting the required routing service and corresponding
channels. In the report, you can select the channels and determine the usage of each
channel by the agent.

Historical reports monthly summary overview
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• How do you compare the performance of agents by routing services for the selected
duration?
Use the Offered and Answered measures to determine the number of engagements
directed and answered. Use the Number of Holds measure to determine the number of
times that the engagements were put on hold by the agent.

• How do you determine the usage of routing services for the selected duration?
Generate reports using different intervals. Analyze the usage pattern of routing services and
associated channels for different intervals to gain an insight on the usage pattern of the
routing services.

Agent Not Ready By Reason Code Monthly
Definition
Displays the reason code associated with the agent Not Ready auxiliary state.

How it works
Tracks the agent activity associated with the agent Not Ready auxiliary state. Supervisors can
view and analyze the reason codes that the agents assign to the Agent Not Ready state for a
selected duration. The duration is aggregated monthly and can be Monthly or Yearly. Data
displayed is listed at agent level, and data is written to the database on the next month.

Business usage
• How many agents are showing the same not ready reason codes and not ready reasons for

the selected duration?
Sort by the Not Ready Reason Code and Not Ready Reason measures to determine the
same codes used by the agents.

• Which are the top reason codes that agents use?
Use the Not Ready Reason Code measure to determine the most used reason codes by the
agents for the selected duration.

• Are agents utilizing the same reason codes multiple times?
Use the Agent ID, Agent User Handle, and Not Ready Reason Code measures to
determine whether agents are using the same codes multiple times in the selected duration.

• Which reason codes are used most by the agents, and what is the maximum duration of
these codes?
Sort by the Not Ready Reason Code measure to determine the codes that have maximum
usage and view the Total Duration measure to determine the duration that agents spent in
the Not Ready auxiliary state for the selected duration.

• Are agents exceeding the thresholds defined for each reason code for the selected duration?
Use the Agent ID, Agent User Handle, and Not Ready Reason Code measures to
determine the reason codes used by agents. Correlate these measures with the Total
Duration measure to determine whether agents are exceeding their threshold.

Agent Not Ready By Reason Code Monthly
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• Which codes are used most by the agents and which code has maximum occurrences for the
selected duration?
Sort by the Not Ready Reason Code measure to determine the codes that have maximum
usage. Correlate it with Occurrences to determine the maximum occurrences of the code.

Agent Performance

Agent Performance Summary Monthly
Definition
Displays the performance and productivity of an agent by Channels for the selected duration.

How it works
Tracks how agents handle contacts delivered to them for the selected duration. Supervisors can
view how the agents handle contacts delivered to them for a selected duration. The duration is
aggregated monthly and can be either Monthly or Yearly. Data displayed is listed at agent level
and data is written to the database the next month.

Business usage
Monitor and compare the performance of each agent for the selected duration to view how the
agents use their time. This report provides answers to some key questions, such as:

• How many contacts were offered to an agent and how many of these contacts were
completed for the selected duration.
Use the Offered measure to determine the number of contacts directed towards the agent for
the selected interval. Use the Completed measure to determine the number of completed
contacts.

• How many contacts did an agent handle for the selected duration, and what is the duration
for which each contact was handled?
Use the Completed measure to determine the number of contacts handled by the agent.

• How do you compare the active duration and idle duration of an agent for the selected
duration?
Compare the Active Time measure with the Idle Time measure to determine the time spent
by an agent in idle state in relation to active state. You can also use the Average Active
Time measure to know the average active time spent by the agent.

• How do you compare the agent's performance for the monthly report with other similar
monthly reports?
Compare the number of contacts offered and the number of contacts completed and
answered with escalations with other similar durations to determine the agent performance.

• Is there an improvement in the performance of the agent?

Historical reports monthly summary overview

November 2021 Using Avaya Analytics™ Reports for Avaya Oceana® 138
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Analytics™‎ Reports for Avaya Oceana®‎


Compare the agent performance in the selected duration with data derived from other
durations to see if the performance of the agent is improving.

• How can you view the agent’s performance at a glance for the selected duration?
See the field Grand Total for all the measures in the table, or hover your mouse over the
measures in Agent Performance Counters.

Agent Performance Top 5 and Bottom 5 Monthly
Definition
Displays a performance summary of the top five and the bottom five agents for the selected
duration.
If more than five agents have the same values for metrics on which the agents are ranked, the
report displays all such agents.

How it works
Tracks the performance of the contact center agents on a monthly basis for the selected duration.
The duration is aggregated monthly and can be either Monthly or Yearly. Data displayed is listed at
agent level and data is written to the database the next month.
The Top 5 report is a monthly report that shows the performance summary of the five agents who
successfully completed the highest number of customer engagements.
The Bottom 5 report is a monthly report that shows the performance summary of the five agents
who completed the lowest number of customer engagements.

Business usage
Monitor and compare the performance of each agent for the selected duration to view how the
agents use their time. This report provides answers to some key questions, such as:

• How many contacts were offered to an agent and how many of these contacts were
completed for the selected duration.
Use the Offered measure to determine the number of contacts directed towards the agent for
the selected interval. Use the Completed measure to determine the number of completed
contacts.

• How many contacts did an agent handle for the selected duration, and what is the duration
for which each contact was handled?
Use the Completed measure to determine the number of contacts handled by the agent.

• How do you compare the active duration and idle duration of an agent for the selected
duration?
Compare the Active Time measure with the Idle Time measure to determine the time spent
by an agent in idle state in relation to active state. You can also use the Average Active
Time measure to know the average active time spent by the agent.

• How do you compare the agent's performance for the current daily report with other similar
daily reports?
Compare the number of contacts offered and the number of contacts completed and
answered with escalations with other similar durations to determine the agent performance.

Agent Performance
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• Is there an improvement in the performance of the agent?
Compare the agent performance in the selected duration with data derived from other
durations to see if the performance of the agent is improving.

• How can you view the agent’s performance at a glance for the selected duration?
See the field Grand Total for all the measures in the table, or hover your mouse over the
measures in Agent Performance Counters.

Agent Compare Monthly
Definition
Displays a comparison of different agent measures.

How it works
Tracks performance of selected agents by comparing different agent measures in the selected
duration. Supervisors can select a maximum of five agents for comparing on different measures.

Business usage
• How many contacts were offered to agents in the selected duration, and how many of these

contacts were completed?
Use the Offered and Completed measures to compare the performance of the agents.

• How many contacts were offered to agents in the selected duration, and how many of these
contacts were abandoned?
Use the Offered and Abandoned measures to compare the number of contacts abandoned
by the agents.

• How many contacts offered to the agents were transferred or conferenced since start of the
month?
Compare the Transferred and Conferenced measures with the Offered measures to know
the count of contacts that were either transferred or conferenced for the selected duration.

Agent Behavior Monthly
Definition
Displays individual occurrences of agent behaviors that are associated with engagement handling
activities.

How it works
Tracks how agents handle contacts delivered to them for the selected duration. Supervisors can
view the agent behaviors for the contacts delivered to them for a selected duration. The duration is
aggregated monthly and can be Monthly or Yearly. Data displayed is listed at agent level and
written to the database on the next month.

Historical reports monthly summary overview
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This report includes counts for the following types of behaviors:
• Duration-based behaviors such as Short Not Ready (aux.) and % Long Holds. Counts for

duration-based behaviors require an administered behavior definition that specifies a time
duration.

• Event-based behaviors such as Transferred, Consults, and Answered that are counted
automatically.

Business usage
• What percentage of calls are transferred or escalated (consults) by the agent for the selected

duration?
Use the % Transferred or % Consults measure to identify the calls that were transferred or
escalated by the agent.

• What percentage of calls are kept on hold by the agent for longer durations for the selected
duration?
Use the % Long Holds measure to identify the agents who keep the calls on hold for
durations longer than the company objectives.

• How do you identify the long engagements that exceed thresholds for the selected duration?
Use the % Long Engagements measure to identify the agents who exceeded the company
objectives.

• How do you identify the agent behaviors that meet or exceed the company objectives?
View the counts of different measures to identify the agent's behavior.

Contact Center Performance Summary Monthly
Definition
Displays the performance summary of a contact center site monthly.

How it works
Tracks behavior aspects and contact activities of a contact center site for the selected duration.
The duration is aggregated monthly and can be either Monthly or Yearly. Supervisors can select
the duration for reporting and track historical performance of the contact center.
This report contains the following summaries:

• Behaviour Summary: Provides information about the various types of agent behaviors that
can have a significant impact on cost of service or customer satisfaction.

• Contact Summary: Provides information about the status of all contacts that dialed in to the
contact center.

Note:
Avaya Analytics™ supports one site only.

Contact Center Performance Summary Monthly
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Business Usage
• How many contacts were offered to the given site for the selected duration and how many of

them were transferred to an agent or a service?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Trans Initiate to Agent and Trans Initiate to Service measures to determine the
number of contacts that were transferred to an agent or a service.

• What does the high number of counts in the Behaviour Summary pie-chart indicate?
Behaviour counts can be attributed to agent behaviour in a contact center and can be
analyzed to determine whether agents need more training or if the efficiency of agents have
reduced. It can also be used to analyze whether agents are performing certain actions that
are greater than set goals of a contact center.

• How many contacts were offered to the given site for the selected duration and how many of
them abandoned while in a queue and how many of them abandoned while alerting?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Abandoned From Queue and Abandoned from Alerting measures to determine
the number of contacts that abandoned from queue or abandoned from alerting.

• How many contacts were offered to the given site for the selected duration and what
percentage of them abandoned while in a queue and what percentage of them abandoned
while alerting?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the % Abandoned From Queue and % Abandoned from Alerting measures to
determine the percentage of contacts that abandoned from queue or abandoned from
alerting.

• How many contacts were offered to the given site for the selected duration and how many of
them were answered and how many of them were not answered?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Answered and Not Answered measures to determine the number of calls answered
and number of calls unanswered.

• How many contacts were offered to the given site for the selected duration and how many of
them were deferred by the agent?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the % Answered and % Not Answered measures to determine the percentage of calls
answered or unanswered.

• How many contacts were offered to the given site for the selected duration and how many of
them were deferred by the agent?
Use the Offered measure to determine the number of contacts offered to the selected site.
Use the Deferred Contacts measure to determine the contacts that the agent answered and
subsequently deferred.

Historical reports monthly summary overview
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Routing Service Summary Monthly
Definition
Displays overall performance of a routing service for the selected duration.

How it works
Tracks the performance of the routing service for the selected duration. The duration is
aggregated monthly and can be Monthly and Yearly.
Supervisors can select the routing services within a routing service group for reporting and track
the channels' historical performance. Supervisors can only view routing services and routing
service measures associated with the routing service group to which they are assigned.
This report displays routing services, their attributes, and channels through which a contact is
routed and provides a snapshot of metric through a Pie chart View.

Business usage
Monitor and compare the performance of each Routing Service for the selected interval.
This report provides answers to some key questions, such as:

• How many contacts has a routing service offered, and how many agents were serviced by
the routing service for the selected interval?
Use the Offered measure to determine the number of contacts offered through the routing
service. Use the Agent Count measure to determine the agents serviced by the routing
service.

• How do you compare the usage of routing services by channels?
Use the Channel measure to determine the usage of multichannel serviced by routing
service.

• How do you determine the performance of a routing service for the selected interval?
Use the % Service Level measure to determine the percentage of engagements with the
routing service. Use the % Occupancy measure to determine the time spent by an agent in
engagement service work for the routing service.

• How do you view the abandoned contacts across routing services?
Click Routing Service Summary - Contacts tab. Input values on the page and click Apply.
Hover the mouse over each pie in the Pie chart View.

• How do you know that the performance of the routing service is improving?
Compare the routing service performance in the current interval with data derived from other
intervals.

Routing Service Summary Monthly
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Supervisor Monthly

Supervisor Activity Monthly
Definition
Displays a summary of the supervisor’s activity for the selected reporting duration.

How it works
Tracks the performance of the routing service for the selected duration. The duration is
aggregated monthly and can be Monthly and Yearly.
From the Inputs prompt, you can filter reports by one or more supervisors.

Business usage
• How do you determine the number of agents that the supervisor was observing?

Use the Observing measure to know the number of contacts where the supervisor was
observing the agent.

• How do you know the number of agents that the supervisor was observing and provided
coaching?
Use the Observing measure to know the number of contacts for which the supervisor was
observing the agent. Use the Coaching measure to know the number of contacts for which
the supervisor provided coaching to the agent.

• How do you determine the number of agents a particular supervisor was observing, provided
coaching to, or barging in on?
Filter the report by Supervisor Name. Use the Observing, Coaching, and Barged In
measures to determine the number of agents where the supervisor was observing, coaching,
or barging in.

Supervised Agent Activity Monthly
Definition
Displays details of supervised agents and their behavior aspects in the selected reporting
duration.

How it works
Tracks how many agents were observed, barged out of contacts, and coached by the supervisor.
Supervisors can view how the agents handle contacts delivered to them for a selected duration.
This includes contacts that the agents transferred to other agents or service.
You can filter the report by:

• Agents: Displays details of the selected agents grouped by their reporting supervisor.
• Supervisor: Displays details for all agents reporting to each supervisor.

Historical reports monthly summary overview
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• Agent Group: Displays details for all agents in the group based on their reporting supervisor.
You can drill down on the Coached, Observed, and Barged Out measures.

Business usage
• How do you determine the number of contacts answered by the agent?

Use the Answered measure to know the number of contacts answered by an agent.
• How do you determine the number of contacts that the supervisor observed or barged out the

agent from the contacts?
Use the Observed and Barged Out measures to know the number of contacts where the
agent was observed or barged out of the contact.

• How do you know the number of contacts for which the agent was observed and coached?
Use the Observed measure to know the number of contacts for which the agent was
observed. Use the Coached measure to know the number of contacts for which the agent
was coached.

• How many contacts did the agent transfer to an agent or a service?
Use the Transferred to Agent and Transferred to Service measures to know the contacts
transferred to another agent or service.

Supervised Agent Compare Monthly
Definition
Displays a comparison of supervised agents for the selected reporting duration.

How it works
Tracks activities of supervised agents by comparing agents on different measures in the selected
duration. Supervisors can select maximum five agents for this activity.
You can filter agents of your interest to see the comparison.
Filter the report by Agent Groups to limit the agents comparison in a group.

Business usage
• How do you compare the supervised agents that were observed and coached?

Use the Observed and Coached measures to compare the activities of the supervised
agents.

• How do you compare the supervised agents that were observed and removed from the call?
Use the Observed and Barged Out measures to compare the activity of the supervised
agents that were removed from the call.

• How many times did the supervisor intervene in the calls for the scheduled duration?
Use the Barged In measure to know the number of times the supervisor intervene in the
calls.

Supervisor Monthly
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Time Series Monthly
Definition
Displays the engagement of agents associated with a routing service for the selected duration.

How it works
Tracks the overall trends in performance of agents and agent engagements with a routing service
in a routing service group against a set service level for the selected duration.
Supervisors can select the routing services within a routing service group for reporting and track
the channels' historical performance. Supervisors can only view routing services and routing
service measures associated with the routing service group to which they are assigned.

Business usage
• How do you determine the usage of each channel for different measures in the selected

duration?
View the Engagements trend graph and use different measures from the drop-down list to
know the usage of each channel.

• How do you determine if the channel is approaching the defined service level for the selected
duration?
View the % Service Level trend graph to know the percentage usage of each channel.

• How do you compare the usage of different channels for the selected duration?
View the % Service Level trend graph to know the percentage usage of each channel.
Analyze the usage pattern of each channel.

• How do you determine what is happening at the routing point for the selected duration?
Use the % Service Level measure to understand the maximum service level reached. View
the Calls Abandoned After Threshold measure to analyze the number of calls abandoned
after the routing service reached its set threshold limit.

• How do you determine if the routing service is used to its fullest for the selected duration?
View the % Service Level measure to determine the calls offered through the routing service
against the set service level.

VDN Summary Monthly
Definition
Displays overall performance of a routing point with respect to the customer experience.
This report supports route point reporting for calls that terminate in treatment VDNs or for callers
who leave a message. Where Avaya Oceana® is non-operational, pre-existing agents are directed
to fallback to Elite.

Historical reports monthly summary overview
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How it works
Tracks the performance of the routing point for the selected duration. The duration is aggregated
monthly and can be either Monthly or Yearly. Supervisors can select the routing points and routing
point sub-type for reporting and track historical performance of the routing points.
Supervisors can use this report to compare routing points with respect to compliance with service
level goals or to compare routing points with other measures.
This report supports the following routing points:

Route Point Type SubType Channels (Oceana®)
VDN INGRESS, RONA,

XFER2SERVICE, FALLBACK,
COVERAGE, and TREATMENT

PSTN VOICE

RoutePoint ROUTING, and XFER2SERVICE OCP Channels

Business usage
• How many contacts were handled by the selected routing point and routing point sub-type for

the selected duration, and how many of them were disconnected?
Use the Handled measure to determine the number of contacts handled by the selected
routing point and routing point subtype for the selected duration . Use the Disconnects
measure to determine the number of contacts that were disconnected.

• How many contacts were handled by the selected routing point and routing pointy sub-type
for the selected duration and how much time was required for routing?
Use the Handled measure to determine the number of contacts handled by the selected
routing point and routing point subtype for the selected duration . Use the Routing Duration
measure to determine the routing duration of these contacts.

• How do you determine the performance of a routing point?
Use the Handled measure to determine the number of contacts handled by the routing point
in the selected duration . Use the Routing Duration measure along with other measures,
such as Disconnects and Average Wait Time, to determine the performance of the routing
point for the selected duration.

• How do you know that the performance of a routing point is improving?
Compare the routing point performance in the scheduled duration with data derived from
other duration.

VDN Summary Monthly
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Chapter 9: Call Profile reports overview

Call Profile reports
This chapter provides a summary of the Call Profile reports for a routing service. Using Call Profile
reports, supervisors can view information about the calls of their routing services and routing service
groups for a selected duration. The following Call Profile reports are available in Avaya Analytics™:

• Call Profile Abandoned
• Call Profile Active Time Duration
• Call Profile Answered
• Call Profile Waiting in Queue

The reports contain information such as whether a call was answered, the duration of a call, the
duration for which a call was waiting in a queue, or whether a call was abandoned. You can
dynamically select different metrics, ranging from 15-minute interval to yearly, and determine which
channel ID recorded the least or maximum calls for a given duration and metric.
Supervisors can also compare call performance of the routing services in the routing service groups
to which they are assigned. Using the information obtained from these reports, they can plan
process improvements or make business decisions for their routing services.
For example, supervisors assigned to a specific routing services group can compare call
performance of the routing services in that group using the Call Profile Abandoned and Call Profile
Answered reports. Of the total number of offered calls, if the number of answered calls is higher
than the number of abandoned calls, it indicates a healthy call performance in the routing services
group. Alternatively, if the number of abandoned calls is higher for a routing services group,
supervisors can plan strategies to improve call processes for that group.
Reports are displayed in a dossier format with additional, dynamic filtering capabilities. For example,
you can click a bar in the Channel ID bar graph to view details only for that particular channel ID in
the details table. Additionally, when you click a bar, the bar graphs update and display only those
channel IDs that are associated with the selected bar.
You can apply additional filters by selecting all or some of the durations, metrics, and channel ID
filters in the left or right panes of the report.
For more detailed information about the measures, data, and reports that Avaya Analytics™

provides, see Avaya Analytics™ Data Dictionary available from the Avaya Support website at https://
support.avaya.com.

Limitation in Call Profile reports
To understand the limitation in Call Profile reports, consider the following scenario:

1. A call is offered in Avaya Analytics™.
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2. The call is queued on Routing Service 1.
3. The call is removed from the queue on Routing Service 1 after one minute.
4. The call is now queued on Routing Service 2.
5. The call is answered on Routing Service 2 after it was waiting in a queue for one hour (or 60

minutes).
6. The call is transferred to Routing Service 3 after one minute.
7. The call is answered on Routing Service 3 and completed after two hours (120 minutes).

In the above scenario, a single call is transferred on three routing services. The call details display in
the Call Profile reports as follows:

• Call Profile Abandoned: No call profile details
• Call Profile Waiting in Queue: 1 minute (step 3) + 1 hour (step 5) = 3660 seconds. This time

displays for Routing Service 1, although for most of the time, the call was waiting in queue on
Routing Service 2.

• Call Profile Answered: 1 minute (step 3) + 1 hour (step 5) = 3660 seconds. This time displays
for Routing Service 2 where the call was answered (step 5).

• Call Proflie Active Time Duration: 1 minute (step 3) + 1 hour (step 5) + 1 minute (step 6) + 2
hours (step 7) = 10920 seconds. This time displays for Routing Service 1.

Call Profile Answered, Call Profile Waiting in Queue, and Call Profile Abandoned reports do not
display accurate information when you run these reports on pre-4.1.1 data. These reports use
measures that are only added in Release 4.1.1. The default value of pre-4.1.1 measures is 0 and,
as a result, the reports display inaccurate data when you run them on pre-4.1.1 data.

Call Profile Abandoned
Definition
Displays a summary of the calls of a routing service that were abandoned during a selected
duration.

How it works
Tracks the number of calls that were abandoned during a selected duration. Supervisors can use
the information to compare different routing services and determine which routing service had the
maximum number of abandoned calls.

Business usage
• How do you understand the call performance of routing services for a given duration?

The Call Profile Abandoned report displays information about the number of calls that were
abandoned for a given duration. For example, to view how many calls related to your routing
services were abandoned in a given quarter, you can use the time filters to select the months
of the quarter. Once you know which routing service registered the maximum number of
abandoned calls, you can plan process improvements for that routing service.

Call Profile Abandoned
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• How do you know which channels of a routing service reported the maximum number of
abandoned calls?
The bar graphs in the report represent the channels of the selected routing service. Each
color-coded bar represents a specific channel.
Hover the mouse pointer over each of the bars to view the number of abandoned calls in that
channel. You can view this information for different intervals and metrics. Once you determine
which channel reported the maximum number of abandoned calls, you can plan process
improvements for those channels.

• How does abandoned call information help organizations to make business decisions?
An abandoned or unanswered call is similar to a missed opportunity, especially in sales or
promotional services. The more the number of abandoned calls, the heavier the losses to an
organization.
For example, a particular routing service consistently reports high numbers of abandoned
calls. In this case, supervisors need to find better strategies to improve call performance and
mitigate the organization's risk of losses.

• How do you determine the call abandonment rate?
Divide the number of abandoned calls by the total number of calls received for a particular
routing service.

• Does the total number of abandoned calls include calls that were dropped while they were on
hold, during alerting after a consultative transfer, or during alerting after a blind transfer a
selected duration?
In an abandoned call, the caller hung up the call before being answered by an agent. Hence,
none of these situations adds up to the count of abandoned calls in the report.

Call Profile Active Time Duration
Definition
Displays a summary of the duration for which the calls were active for a routing service.

How it works
Tracks the number of calls that were active during a selected duration. Supervisors can compare
the routing services within a routing service group and determine the minimum and maximum time
spent on calls in each of these routing services.

Business usage
• How can supervisors improve call performance based on the information in the Call Profile

Active Time Duration report?
Compare the data of the calls that each routing service handles and their active duration
within and across routing services. Use this comparison to take business decisions to
improve and optimize call times, particularly for those routing services where the active times
are excessively high.

Call Profile reports overview
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• How do you determine whether the active call duration was on a higher side?
Set a threshold limit for an active call duration. After the threshold, the calls can be deemed
as long-duration calls.

• What risks do calls with long active time durations pose?
When an active call lasts too long, the number of calls waiting in queue could significantly
increase. There is also the risk of calls getting abandoned. You must review call active time
durations for their routing services and find ways to reduce these times so that calls are not
kept waiting for too long.

Call Profile Answered
Definition
Displays a summary of the calls of a routing service that were answered during a selected interval.

How it works
Tracks the number of calls that were answered. Supervisors can determine how many calls were
answered for each of the routing services in a routing service group for a selected duration.

Business usage
• What is the significance of information displayed in this report?

This report displays which routing services report the maximum number of calls answered
within the shortest interval. Such calls with quick response times indicate a healthy call profile
environment for that routing service. You can replicate this process in other routing services
where the intervals of answered calls or the number of waiting and abandoned calls are high.

• How do you determine the best performing channel ID in terms of calls answered in the
shortest interval?
Hover the mouse pointer over each of the bars to view the type of channel and the number of
answered calls. You can view this information for each of the channels for different intervals
and metrics. Once you determine which channel reported the minimum number of answered
calls, you can then plan process improvements for these channels to improve their answering
rates.

• How do you calculate the service level of the calls associated with the routing services in
your routing service groups?
Divide the number of calls answered in n seconds by the total calls offered for the selected
duration multiplied by 100.
For example, if the total number of offered calls in a given month was 6000, of which the
number of answered calls in n seconds was 5400, then the service level is calculated as:
5400/6000 * 100 = 90

A high service-level rate is an indicator of a healthy call performance standard.

Call Profile Answered
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Call Profile Waiting in Queue
Definition
Displays a summary of the calls of a routing service that were waiting in queue during a selected
duration.

How it works
Tracks the number of calls that were queued. Supervisors can determine the maximum time that a
call was waiting in a queue for a routing service.

Business usage
• How do you improve call performance based on the information in this report?

In the bar graph, each color-coded bar represents a different channel. Hover the mouse
pointer over each of the bars to view the type of channel, number of waiting calls, and their
duration. View this information for different intervals and metrics. Once you determine which
channel reported the maximum number of waiting calls, you can plan steps to improve and
optimize call times, particularly for those routing services where the waiting times are
excessively high.

• How do you determine which routing services have high customer satisfaction rates?
Analyze the report to determine calls waiting in queue for the shortest duration in routing
services. You can consider the routing service with the maximum number of such calls as
having high customer satisfaction rates.

Call Profile reports overview
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Chapter 10: Resources

Documentation

Title Use this document to: Audience
Overview
Avaya Oceana® Solution
Description

Know about tested product
characteristics and capabilities,
including product overview and
feature descriptions,
interoperability, performance
specifications, security, and
licensing requirements.

• Sales engineers

• Business partners

• Solution architects

• Implementation engineers

Implementing
Deploying Avaya Oceana® Deploy Avaya Oceana®. • Sales engineers

• Business partners

• Solution architects

• Implementation engineers
Avaya Oceana® and
Avaya Analytics™ Disaster
Recovery

Know about how to restore Avaya
Oceana® when a complete outage
at the primary data center.

• Sales engineers

• Business partners

• Solution architects

• Implementation engineers
Upgrading Avaya
Oceana®

Upgrade Avaya Oceana®. • Sales engineers

• Business partners

• Solution architects

• Implementation engineers
Deploying Avaya
Analytics™

Deploy Avaya Analytics™. • Sales engineers

• Business partners

• Solution architects

• Implementation engineers
Administering

Table continues…
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Title Use this document to: Audience
Administering Avaya
Oceana®

Administer Avaya Oceana®. • System administrators

• Supervisors
Using
Using Avaya Workspaces
for Avaya Oceana®

Use Avaya Workspaces for Avaya
Oceana®.

• Agents

• Supervisors
Using Avaya Analytics™ Use the features and capabilities

of Avaya Analytics™.
• Supervisors

• Administrators

• Report designers
Avaya Analytics™ Data
Dictionary

Use historical and real-time
measures in custom reports.

• Administrators

• Report designer
Maintaining and Troubleshooting
Maintaining and
Troubleshooting Avaya
Oceana®

Perform maintenance and
troubleshooting procedures for
routine maintenance and
troubleshooting of Avaya
Oceana®.

• Support personnel

• Implementation engineers

• Administrators

Maintaining and
Troubleshooting Avaya
Analytics™

Perform common maintenance
functions of Avaya Analytics™ and
use tools and utilities for
troubleshooting of Avaya
Analytics™.

• Support personnel

• Implementation engineers

• Administrators

Avaya Oceana® Alarms View details about Avaya Oceana®

alarms.
• Support personnel

• Administrators

Finding documents on the Avaya Support website
Procedure

1. Go to https://support.avaya.com.

2. At the top of the screen, type your username and password and click Login.

3. Click Support by Product > Documents.

4. In Enter your Product Here, type the product name and then select the product from the
list.

5. In Choose Release, select the appropriate release number.

The Choose Release field is not available if there is only one release for the product.

6. In the Content Type filter, click a document type, or click Select All to see a list of all
available documents.

Resources
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For example, for user guides, click User Guides in the Content Type filter. The list only
displays the documents for the selected category.

7. Click Enter.

Avaya Documentation Center navigation
For some programs, the latest customer documentation is now available on the Avaya
Documentation Center website at https://documentation.avaya.com.

Important:

For documents that are not available on Avaya Documentation Center, click More Sites >
Support on the top menu to open https://support.avaya.com.

Using the Avaya Documentation Center, you can:

• Search for keywords.

To filter by product, click Filters and select a product.

• Search for documents.

From Products & Solutions, select a solution category and product, and then select the
appropriate document from the list.

• Sort documents on the search results page.

• Click Languages ( ) to change the display language and view localized documents.

• Publish a PDF of the current section in a document, the section and its subsections, or the
entire document.

• Add content to your collection using My Docs ( ).

Navigate to the Manage Content > My Docs menu, and do any of the following:

- Create, rename, and delete a collection.

- Add topics from various documents to a collection.

- Save a PDF of the selected content in a collection and download it to your computer.

- Share content in a collection with others through email.

- Receive collection that others have shared with you.

• Add yourself as a watcher using the Watch icon ( ).

Navigate to the Manage Content > Watchlist menu, and do the following:

- Enable Include in email notification to receive email alerts.

- Unwatch selected content, all content in a document, or all content on the Watch list page.

As a watcher, you are notified when content is updated or deleted from a document, or the
document is removed from the website.

Documentation
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• Share a section on social media platforms, such as Facebook, LinkedIn, and Twitter.

• Send feedback on a section and rate the content.

Note:

Some functionality is only available when you log in to the website. The available functionality
depends on your role.

Training
The following courses are available for the Avaya Oceana® program.

Table 1: Sales Credentials

Course
code

Course title Course duration in
hours

Delivery type

APSS – 1202 Avaya IX™ Contact Center Solutions for Sales
41510W Avaya IX™ Contact Center Portfolio

Overview (for Sales)
0.75 Web-based Training

41550T APSS Avaya IX™ Contact Center
Solutions

1.0 Web-based Training

ALCC –2005 Avaya IX™ Voice and Digital Solutions for Sales
41710W The Avaya IX™ Contact Center

Automated Story
0.50 Web-based Training

41410W Selling Avaya Oceana® 0.75 Web-based Training
41400W Selling Avaya Avalytics™ 0.50 Web-based Training
41480W The Basics of Cost Justification and

Selling Avaya Oceana® Using the
ROI Tool

0.50 Web-based Training

41770W Avaya Experience Portal and
Proactive Outreach Manager (POM)
for Sales

0.25 Web-based Training

Table 2: Pre-Sales Design

Course
code

Course title Course duration in
hours

Delivery type

ACDS – 3480 Avaya Oceana® Design
34210W Avaya Oceana® Overview for Design 1.0 Web-based Training

Table continues…
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Course
code

Course title Course duration in
hours

Delivery type

34810W Designing the Avaya Oceana® Part 1
of 3

1.0 Web-based Training

34820W Designing the Avaya Oceana® Part 2
of 3

1.50 Web-based Training

34830W Designing the Avaya Oceana® Part 3
of 3

1.50 Web-based Training

34800X Avaya Oceana® Design Exam 1.50 Exam
ALRI-7001 Avaya Oceana® Product Release Information Collection

39000W Avaya Oceana® Release 3.8 Details
for Pre-Sales

1.0 Portable Document
Format (PDF)

39010W Avaya Avalytics™ Release 3.8 and
4.1 Details for Pre-Sales

1.0 PDF

39020W Avaya Breeze® Snap-Ins for Avaya
Oceana® R3.8 Details for Pre-Sales

1.0 PDF

Table 3: Technical Services Partner Credentials

Course
code

Course title Course duration in
hours

Delivery type

ACIS – 7495 Avaya Oceana®

74150V Integrating Avaya Oceana® Core and
Workspaces

40.0 Virtual Instructor-Led
Training

7495X Avaya Oceana® Integration Exam 1.50 Exam
ACSS-7497 Avaya Oceana®

74550V Supporting Avaya Oceana® 24 Virtual Instructor-Led
Training

7497X Avaya Oceana® Support Exam 1.75 Exam
ACSS-7498 Avaya Analytics ™ Insights

74360V Integrating and Supporting Avaya
Analytics™ R4

40.0 Virtual Instructor-Led
Training

74980X Avaya Analytics™ Insights Integration
and Support Exam

1.75 Exam

Training
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Table 4: Pre-requisite Courseware

Course
code

Course title Course duration in
hours

Delivery type

77900W Avaya Control Manager Training
Bundle (5 courses 21900W,
77910W, 77920W, 77930W,
77940W)

5.50 Web-based Training

70160W Avaya Breeze® Implementation
and Support

30.0 Web-based Training

Table 5: End User, Programmer, Administration

Avaya Learning Center
Course
code

Course title Course duration in
hours

Delivery type Vanity Link for
Attachment

ALEU-5002 Avaya Oceana® End-User Training
24020W Using Avaya Workspaces for

Avaya Oceana® - Agent
1.0 Web-based

Training
https://
www.avaya.com
/oceana-agent

24040W Using Avaya Workspaces for
Avaya Oceana® - Supervisor

1.0 Web-based
Training

https://
www.avaya.com
/oceana-
supervisor

ALUC-4001 Avaya Breeze® Client SDK
2410W Customer Communications and

Apps with Oceana® for
Developers

3.0 Web-based
Training

ASDC-0010 Avaya Workspaces® Framework
24150W Creating Avaya Oceana®

Workspaces Framework for
Developers

2.0 Web-based
Training

24150W Avaya Workspaces Framework
R3 Test

1.0 Online Test

ASAC-0010 Avaya Oceana® Administration
21160W Avaya Oceana® Fundamentals 0.5 Web-based

Training
24300V Avaya Oceana® Administration

Training
40.0 Virtual

Instructor-Led
Training

Attached with
the sale

24300T Administering Avaya Oceana®

R3 Online Test
1.0 Online Test

Table continues…
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Avaya Learning Center
Course
code

Course title Course duration in
hours

Delivery type Vanity Link for
Attachment

24320W Administering Avaya Oceana® -
Basic

2.5 Web-based
Training

https://
www.avaya.com
/Oceana-admin

ASAC-0022 Administering Avaya Analytic™ for Avaya Oceana®

24380W Administering Avaya Analytics™

for Oceana®
1.5 Web-based

Training
https://
www.avaya.com
/Oceana-
analyticsadmin

24310T Administering Avaya Analytics™

R3 for Oceana® Basic Online
Teat

1.0 Web-based
Training

Table 6: Other Miscellaneous Courseware

Course
code

Course title Course duration in
hours

Delivery type Vanity Link for
Attachment

ALCC-0001 Avaya Workforce Optimization Select Integration with Avaya Oceana® Workspaces
7014W Integrating Avaya Workforce

Optimization Select with Avaya
Oceana® Workspaces

3.0 Web-based
Training

7014A Avaya Workforce Optimization
Select with Avaya Oceana®

Workspaces Integration
Assessment

1.0 Assessment

70170W Integrating Avaya Workspaces
with Avaya Aura Call Center
Elite

1.0 Web-based
Training

70170T Avaya Workspaces for Elite
Integration Online Test

1.0 Online Test

71610W Integrating POM with Avaya
Oceana®

1.0 Web-based
Training

71610T Proactive Outreach Manager
with Avaya Oceana® Integration
Online Test

1.0 Online Test

ALEU-5005 Avaya Workspaces for Elite End User
24120W Using Avaya Workspaces for

Elite – Agents
0.75 Web-based

Training
https://
www.avaya.com
/elite-
workspaces-
agent
Table continues…

Training
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Course
code

Course title Course duration in
hours

Delivery type Vanity Link for
Attachment

24140W Using Avaya Workspaces for
Elite – Supervisor

0.50 Web-based
Training

https://
www.avaya.com
/elite-
workspaces-
supervisor

Support
Go to the Avaya Support website at https://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Using the Avaya InSite Knowledge Base
The Avaya InSite Knowledge Base is a web-based search engine that provides:

• Up-to-date troubleshooting procedures and technical tips

• Information about service packs

• Access to customer and technical documentation

• Information about training and certification programs

• Links to other pertinent information

If you are an authorized Avaya Partner or a current Avaya customer with a support contract, you
can access the Knowledge Base without extra cost. You must have a login account and a valid
Sold-To number.

Use the Avaya InSite Knowledge Base for any potential solutions to problems.

1. Go to http://www.avaya.com/support.
2. Log on to the Avaya website with a valid Avaya user ID and password.

The system displays the Avaya Support page.
3. Click Support by Product > Product-specific Support.
4. In Enter Product Name, enter the product, and press Enter.

5. Select the product from the list, and select a release.
6. Click the Technical Solutions tab to see articles.
7. Select relevant articles.

Resources
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